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IMPORTANT INFORMATION 

DISCLAIMER AND LIMITATION OF LIABILITY

DEQX Pty. Ltd. (‘DEQX’) assumes no responsibility for loss or damage resulting from the use of 
any of its products. 

Refer to the license supplied with the DEQX® Calibration software (pages 3 and 4). 

Specifications are subject to change without notice. 

Contact DEQX Support at http://deqx.com/support.php for installation and operational support. 
We highly recommend using the DEQXpert™ on-line installation and/or training service. 

The exclamation point within a triangle is intended to alert the user to the 
presence of important operating and maintenance instructions in the 
literature accompanying the product. 

The lightning with arrowhead symbol within a triangle is intended to alert 
the user to the presence of un-insulated “dangerous voltage” within the 
products’ enclosure that may be of sufficient magnitude to constitute a risk 
of electrical shock to person.

 

WARNING 
To prevent fire or shock hazard, do not expose the unit to rain or moisture. To avoid electrical 
shock, do not open the unit. No user-serviceable parts are inside. Refer any servicing to qualified 
personnel. 

 

Caution: Damage may result to your speaker drivers and other equipment if your audio system is 
connected incorrectly or if the unit is used incorrectly. Read this user manual in full before 
configuring your hardware and refer to your speaker manufacturer's specifications to ensure 
correct connection. If you are in doubt as to as the connection of your audio equipment, seek 
assistance from a professional audio installer or contact DEQX at http://deqx.com/support.php. 

ALWAYS TURN THE DEQX UNIT AND ANY ASSOCIATED AUDIO EQUIPMENT 
OFF BEFORE CONNECTING OR DISCONNECTING AUDIO CABLES. 

ANY AUDIO EQUIPMENT REQUIRING GROUNDING MUST BE GROUNDED TO 
THE SAME POINT (CIRCUIT) AS THE DEQX UNIT. 

FAILURE TO OBSERVE THESE WARNINGS CAN RESULT IN DAMAGE TO THE 
DEQX UNIT AND OTHER AUDIO EQUIPMENT AND MAY NOT BE COVERED BY 
WARRANTY. 

 

http://deqx.com/support.php
http://deqx.com/support.php
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IMPORTANT SAFETY INSTRUCTIONS 
Read these instructions entirely before installing or operating this product. Keep these 
instructions. Heed all warnings. Follow all instructions. 

 

Do not use this product near water. Clean only with a dry cloth. 

Do not block any ventilation openings. Install in accordance with the manufacturer’s 
instructions. 

Do not install near any heat source such as radiators, heat registers, stoves, or other apparatus 
(including amplifiers) that produce heat. 

Do not defeat the safety purpose of the grounding-type safety plug. A grounding-type plug has 
two blades and a third grounding prong or blade. The third prong or blade is provided for your 
safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of 
the obsolete outlet. 

Protect the power cord from being walked on or pinched, particularly at the plug and the point 
where the cord exits from this product. 

Do not use this product with a damaged cord or plug. 

Only use attachments and accessories specified by the manufacturer. 

Unplug this product during lightning storms or when unused for long periods of time. 

Refer all servicing to qualified service personnel. Servicing is required when the product has been 
damaged in any way, such as when the power cord or plug are damaged, liquid has been spilled 
or objects have fallen into the product, the product has been exposed to rain or moisture, does 
not operate normally, or has been dropped. 

CLEANING AND MAINTENANCE 
Always unplug the product from the electrical outlet before cleaning. Do not use abrasive 
cleaners. Simply wipe the exterior with a clean soft cloth. A small amount of non-abrasive 
cleaner may be used on the cloth to remove any excessive dirt or fingerprints. 

LICENSE 
This is a legal agreement (‘Agreement’) between you (either an individual or an entity), the end 
user, and DEQX Pty Limited, Sydney, Australia. By installing, copying, or otherwise using the 
Product (as defined below), you agree to be bound by the terms of this Agreement. If you do not 
agree to the terms of this Agreement, do not install, copy, or use the product, and promptly 
return the disks and any accompanying items (including written materials and binders or other 
containers, if any) to DEQX Pty Limited. 

DEQX LICENSE AGREEMENT for one Copy of DEQX-Cal™ Acoustic Calibration Software and 
Firmware © 2004–2016 DEQX Pty Limited. All rights reserved. 

GRANT OF LICENSE 
DEQX grants the ‘Recipient’ a limited, nonexclusive, non-transferrable, royalty-included with 
hardware purchase, license to make and use DEQX-Cal™ software (‘Product’) to be installed on 
approved Windows platforms for Recipient's use ONLY with DEQX® speaker and room 
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calibration products including but not limited to PDC-2.6, PDC-2.6P, HDP-3, HDP-4, HDP-5, 
DEQX MATE, PreMATE, PreMATE+, HDP-Express, and HDP-Express II. 

All other rights are reserved to DEQX. Recipient shall not rent, lease, sell, sublicense, assign, or 
otherwise transfer the Product, any accompanying printed materials (‘Documentation’), or a 
digital content created with the Product (‘Filter coefficients’). Recipient may not reverse 
engineer or decompile the Product. DEQX and its suppliers shall retain title and all ownership 
rights to the product, and this Agreement shall not be construed in any manner as transferring 
any rights of ownership or license to the Product or to the features or information therein, 
except as specifically stated herein. 

TERM OF AGREEMENT 
The term of this Agreement shall commence on the date you accept this Agreement and shall 
continue unless terminated by DEQX in writing at any time, with or without cause. In the event 
that DEQX terminates this agreement, Recipient shall promptly return to DEQX, or certify 
destruction of, all full or partial copies of such product and related materials provided by DEQX. 

PRODUCT MAINTENANCE 
DEQX is not obligated to provide maintenance or updates to Recipient for Product licensed 
under this Agreement. 

DISCLAIMER OF WARRANTY 
DEQX-Cal™ software (‘Product’) is deemed accepted by Recipient upon first use. The PRODUCT 
IS PROVIDED ‘AS IS’ WITHOUT WARRANTY OF ANY KIND. TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, DEQX FURTHER DISCLAIMS ALL WARRANTIES, 
INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. THE ENTIRE RISK 
ARISING OUT OF THE USE OR PERFORMANCE OF THE PRODUCT AND DOCUMENTATION 
REMAINS WITH RECIPIENT. 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL DEQX 
OR ITS SUPPLIERS BE LIABLE FOR ANY CONSEQUENTIAL, INCIDENTAL, DIRECT, INDIRECT, 
SPECIAL, PUNITIVE, OR OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS 
OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF 
OR INABILITY TO USE THE PRODUCT OR DOCUMENTATION, EVEN IF DEQX HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

GOVERNING LAW; ATTORNEY’S FEES 
The laws of the State of New South Wales, Australia shall govern this Agreement and Recipient 
further consents to jurisdiction by the state and Australian federal courts sitting in the State of 
New South Wales. If either DEQX or Recipient employs attorneys to enforce any rights arising 
out of or relating to this Agreement, the prevailing party shall be entitled to recover reasonable 
attorneys' fees. 

COPYRIGHT 
Copyright © 2004–2016 DEQX Pty Ltd, Sydney, NSW, Australia (‘DEQX’). DEQX® and DEQX-
Cal™ are trademarks of DEQX Pty Ltd. All other product or brand names referenced in this 
manual may be trademarks or registered trademarks of their respective owners. 
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1 WELCOME TO DEQX 

Congratulations on purchasing a DEQX® High Definition Preamp Processor. Your 
DEQX is one of the most advanced audio processors in the world, with patented digital 
audio processing, advanced algorithmic design, and an impeccable pedigree focused on 
delivering the best possible performance from a high-end audio system. 

The DEQX® Preamp Processor tackles head-on the most fundamental issues of high-
fidelity speaker design. It is used in the world's most technically advanced speakers. In 
addition, any speaker can be improved by deploying a DEQX processor. In most high-
end home or professional audio systems, the DEQX completely replaces the preamp 
and the DAC. (The HDP-5 and PreMATE+ also act as a networked streaming audio 
destination, further simplifying system configuration.) 
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1.1 SYSTEM CONFIGURATIONS 

The DEQX® Preamp Processor is a powerful and flexible tool. In its first mode of 
operation, the DEQX acts as preamp, DAC, and correction processor for a conventional 
pair of full range1 speakers. The diagram on the previous page illustrates a typical 
system configuration. The speakers usually contain multiple transducers, or drivers, and 
a passive crossover that divides the frequency range between the drivers. The DEQX 
also integrates either mono or stereo subwoofers. 

In that mode of operation, known as “single amp” in this manual, the DEQX and its 
accompanying DEQX-Cal™ software calibrate the speaker, correct for the room, and 
provide a fine-grained Preference EQ for different listening situations, media, and even 
for individual recordings. 

In its more advanced “HD-active speaker” mode of operation (applicable to HDP 
models only), the DEQX also implements steep linear-phase active crossovers between 
the individual drivers in the speaker. Used by speaker designers and advanced 
enthusiasts, this third-generation active speaker architecture takes the passive 
crossovers out the equation completely, allowing complete optimization of the 
individual transducers by the DEQX. This diagram illustrates: 

                                                                    
1 By “full range,” we are referring to the frequency range covered by the speaker – nominally 
20 Hz to 20 kHz, although few speakers (without subwoofers) extend as low as 20 Hz. 
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1.2 HOW DEQX® CALIBRATION WORKS 

Compared to every other component in the audio recording, production, media and 
playback chain, the mechanical nature of speakers makes them extraordinarily prone to 
errors and distortion that detract from realism. These include timing or phase errors 
where numerous “groups” of frequencies lag behind others to varying degrees; 
amplitude (volume) errors that result in inaccurate tonal characteristics; and frequency-
dependent distortion many times higher than the signal from the electronics. 

The advanced algorithms in DEQX software analyze the behavior of the speaker based 
on anechoic measurements, creating detailed corrections that calibrate the transducers 
(“drivers”) and correct for these errors. Each speaker or driver can be calibrated 
individually for the utmost in reproduction accuracy. These detailed corrections are 
then assembled into a configuration of filters that is uploaded to the DEQX, and which 
it uses to process the audio signal that you ultimately hear as music in your listening 
room. This measure-calibrate-configure cycle is the core of optimizing your speakers 
using DEQX. 

1.3 HOW TO USE THIS MANUAL 

Chapters 2 through 4 guide you through the initial hardware setup and describe the 
front panel and the DEQX Remote. You will need to come back to these chapters to re-
read the more in-depth sections, such as the three-band Preference EQ. 

Chapter 5 walks you through the initial setup of DEQX-Cal. We strongly recommend 
that you carefully follow this chapter. Chapters 6 to 9 will guide you through your first 
measure-calibrate-configure cycle. These chapters are both tutorial and reference. 

Chapters 10 to 12 deal with room-related issues: room measurement, subwoofer 
integration, and room EQ. Chapters 13 and 14 are for speaker designers and advanced 
enthusiasts implementing active speakers with DEQX. The remaining chapters and the 
appendixes provide detailed reference information. 

1.4 DEQXPERT CONSULTATION 

Your purchase of a new PreMATE, PreMATE+, HDP-4 or HDP-5 includes an initial 
DEQXpert™ consultation. (It is an optional upgrade for the HDP-Express II.) This 
consultation gets you started with your initial setup. We will walk you through the steps 
to set up your speakers and microphone, and control your computer remotely (with 
your permission) to perform your first measure-calibrate-configure cycle. 

After your initial consultation, you will have a set of profiles configured that you can 
switch between with the DEQX remote. You can use the guidance in this manual to 
continue to refine your configuration, or purchase additional DEQXpert™ consultation 
to have us do it for you. For more information, see http://deqx.com/deqxpert.php. 

http://deqx.com/deqxpert.php
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1.5 WARRANTY REGISTRATION 

To register your DEQX, fill in the warranty registration form on our website: 

 http://deqx.com/warranty.php 

After registering, you will receive a return email with information and a password to 
obtain software updates, microphone calibration files, and documentation downloads. 
In addition, by registering, DEQX will be able to keep you informed of any important 
updates. 

1.6 OBTAINING SUPPORT 

To obtain support, fill in the support form on our website: 

http://deqx.com/support.php 

If you provide as much information as you can in the form, it will help us to troubleshoot 
your issue more effectively. It is important to be as complete as possible. 

1.7 A NOTE ON DEQX LEGACY PRODUCTS 

This manual applies to the current generation of DEQX products: PreMATE, PreMATE+, 
HDP-4, HDP-5, and HDP-Express II. The DEQX-Cal™ software continues to be fully 
compatible with DEQX legacy products, including the PDC-2.6, PDC-2.6P, HDP-3, 
DEQX Mate, and HDP-Express. The following features present in DEQX-Cal are 
intended for legacy products only: 

x 48 kHz operation, selectable in the configuration window (page 72). Current 
generation products should always be set for 96 kHz operation. 

x External digital clock, selectable in the IO Manager (page 134). Current generation 
products do not require or support this option. 

x Analog-only output, selectable in the IO Manager (page 134). Current generation 
products always have digital outputs enabled. (Note that all outputs are isolated, so 
there is no benefit to be gained by turning off the digital outputs.) 

x Digital Upsampling and Analog 96 kHz, selectable in the IO Manager (page 135). 
Current generation products always use digital upsampling and analog 96 kHz 
operation, so these options have no effect. 

Note also that some legacy products may require a firmware upgrade to be controlled 
over the USB interface by the current version of DEQX-Cal. For these products, connect 
first via RS-232 and check the firmware version in the IO Manager. If it is not version 
45.6 or higher, upgrade the firmware (page 167) and then try a USB connection. 

http://deqx.com/warranty.php
http://deqx.com/support.php
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2 INSTALLATION AND CONNECTIVITY 

This chapter guides you through the hardware setup of the DEQX. 

2.1 UNPACKING THE UNIT 

Carefully remove the unit and the accessory kit from the shipping carton. Visually check 
for shipping damage. Contact both the shipper and DEQX immediately if the unit or any 
of the accessories bear any sign of damage from mishandling. All DEQX equipment is 
carefully inspected before leaving our factory. 

Keep the shipping carton and packing materials for future use or in the unlikely event 
that the product needs servicing. If the product is shipped without the original 
packaging, damage could occur and void the warranty. 

Accessory kit contents 

You should find the following in the accessory kit: 

x One (1) AC mains cable 

x One (1) USB cable 

x One (1) microphone cable 

x One (1) CD-ROM with the DEQX Calibration software and USB drivers 

x One (1) measurement microphone with microphone holder 

x One (1) remote control 

x Two (2) AAA batteries 

x One (1) printed User Manual (additional documentation is located on the CD-ROM) 
Physical installation 

The DEQX must be placed on a sturdy level surface, such as a shelf or in a suitable rack 
or cabinet. Allow a minimum of 5 cm (2 inches) on both sides for ventilation. 

During initial setup and calibration, it may be preferred to not install the unit within a 
rack or cabinet, in order to allow easy access to the rear panel. 
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2.2 REAR PANEL OVERVIEW 

All DEQX units are variations on a theme, designed to provide a high degree of 
flexibility in connecting your new DEQX into your audio system. Each features a full 
complement of five digital inputs as well as balanced and unbalanced analog inputs. 
The HDP-5 and PreMATE+ also act as a networked streaming audio destination via their 
Ethernet port. Specific units differ in output connectivity with different analog and 
digital output configurations according to intended use.2 

                                                                    
2 The HDP-4 and PreMATE lack the USB A, Ethernet, and 12V Trigger connectors in the center of 
the rear panel. The HDP-4 has an additional switch for mains input voltage selection. 



Chapter 2. Installation and Connectivity 

 17 

2.3 ANALOG INPUTS 

All DEQX units have two stereo analog input pairs: unbalanced and balanced. The two 
input pairs are independent, and are selectable with the DEQX Remote and from within 
DEQX-Cal. On the HDP-5 and PreMATE+, inputs can also be selected with the 
touchscreen display. 

Unbalanced input (Analog 1) 

This is a stereo input pair on standard RCA connectors. Use a suitable pair of RCA 
line-level interconnect cables to connect an analog source. Alternatively, this 
input can be connected to an analog preamp. If necessary, the sensitivity of this 
input can be adjusted by hardware jumpers (see Appendix D). 

Balanced input (Analog 2) 

This is a stereo input pair for connecting to balanced equipment. Use a suitable 
pair of high quality balanced XLR cables to connect an analog source. 
Alternatively, this input can be connected to an analog preamp. 

 
 NOTES ON MAKING AND BREAKING CONNECTIONS  

1. Power off the DEQX with the rear panel switch before changing any input or 
output audio connections. All connected equipment should also be powered off. 

2. When connecting to the rear panel, double-check that the connections are made 
correctly. If the DEQX is installed in a rack or cabinet, use good light so that the 
labeling is clearly visible. 

3. Confirm output connections using the diagrams on pages 23, 107, and 108. 

4. Push RCA connectors straight on and pull them straight off – avoid twisting them 
to get them on and off.  
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2.4 DIGITAL INPUTS 

All DEQX units have a full complement of digital inputs. Digital inputs are selectable 
with the DEQX Remote and from within DEQX-Cal. On the HDP-5 and PreMATE+, 
inputs can also be selected with the touchscreen display. 

TOSLINK optical (DIG 1) 

This is a standard digital audio optical connection that accepts standard sample 
rates up to 96 kHz. 

S/PDIF on BNC (DIG 2) 

This is an S/PDIF digital input via a 75 Ω (75 ohm) BNC connector. Connecting a 
source with S/PDIF output over BNC and a 75 Ω cable provides optimum digital 
signal transmission. It accepts all standard sample rates up to 192 kHz. 

S/PDIF on RCA (DIG 3) 

This is an S/PDIF digital input via RCA connector. It accepts all standard sample 
rates up to 192 kHz. 

AES/EBU on XLR (DIG 4) 

This is an AES/EBU digital input via XLR connector. It accepts all standard sample 
rates up to 192 kHz. 

USB Audio 

This is an asynchronous USB Audio Class 2 input for connection to a computer or 
high-end music server/streamer. It accepts PCM audio at all standard sample 
rates up to 192 kHz. For Windows, a driver will need to be installed (see 
Appendix B on page 161). 

The HDP-5 and PreMATE+ also act as a networked streaming audio destination via the 
Ethernet jack in the center of the rear panel. See Appendix C for details. 
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2.5 ANALOG OUTPUTS 

The set of analog outputs varies by model. In all cases, the maximum output voltage 
can be set by internal jumpers (see Appendix D). The connections made to the analog 
outputs depend on the chosen system configuration – see the explanatory box on 
page 23 for use with full range passive speakers and pages 107–108 for active speakers. 

HDP-4 and HDP-5 

The HDP-4 and HDP-5 have three pairs of outputs, provided by separate 
unbalanced (on RCA) and balanced (on XLR) circuits. In accordance with the full 
tri-amped output configuration (page 108), each pair is labeled Low, Mid/Full, 
and High. Individual outputs are labeled L1/R1, L2/R2, and L3/R3. 

HDP-Express II 

The HDP-Express II has three pairs of outputs as per the HDP-4 and HDP-5, 
provided as unbalanced signals on RCA connectors. The HDP-Express II does not 
have balanced outputs. 

PreMATE and PreMATE+ 

The PreMATE and PreMATE+ 
have two pairs of outputs, 
labeled Subwoofers and Main 
Speakers, provided by 
separate single-ended (on 
RCA) and balanced (on XLR) 
circuits. Individual outputs are 
labeled L1/R1 and L2/R2. 
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2.6 DIGITAL OUTPUTS 

The HDP-4 and HDP-5 provide a full complement of digital outputs, as shown above. All 
digital outputs are on professional 75 Ω (75 ohm) BNC connectors and produce an 
S/PDIF digital audio stream at 96 kHz sample rate. (BNC-RCA adapters can be used for 
connection of RCA digital cables.) See page 24 for an example of the use of digital 
outputs. 

Digital Thru 

This is the selected stereo input signal (analog or digital), with no correction or 
processing applied. It is used to create more complex system configurations by 
chaining multiple DEQX units (see Chapter 14). Digital Thru does not have volume 
control or any form of filtering or other processing applied to it. 

Low, Mid/Full, High 

These three stereo digital outputs carry the same signal as the analog Low, 
Mid/Full, and High outputs. They can be used to connect external DACs instead 
of using the internal DACs of the DEQX. 

The PreMATE and PreMATE+ provide a single digital output: 

Full 

This is the same signal as provided on the Main Speakers analog output. It carries 
the corrected audio signal for the speakers, optionally with limit filters for 
subwoofer integration. It can be used to connect an external DAC instead of using 
the internal DAC of the DEQX. 

The HDP-Express II does not have digital outputs. 
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2.7 CONTROL/DATA INTERFACES 

The rear panel contains a number of control/data interfaces. 

USB Control 

The USB Control socket is located at the lower left of 
the rear panel (when facing the rear panel). Use the 
supplied USB cable to connect the DEQX to your 
computer when running DEQX-Cal. 

(For PreMATE+ and HDP-5 owners: when the DEQX 
detects communication from the DEQX-Cal software 
over USB, the LCD touchscreen will be disabled and 
will power off after a time.) 

RS-232 

The top RS-232 port is an input control port. It is used when the DEQX is a slave 
unit in a multi-DEQX system (Chapter 14). It can also be used to control the DEQX 
from certain home automation systems (e.g. Crestron). In the latter case, contact 
DEQX directly for details of the RS-232 control protocol. 

The bottom RS-232 port is an output control port, used in master-slave 
configurations with multiple DEQX units (see Chapter 14). 

Ethernet (PreMATE+ and HDP-5 only) 

The Ethernet port is used for networked streaming audio. 
See Appendix C for full information on this feature. 

USB (PreMATE+ and HDP-5 only) 

The USB (Type A) port is used for firmware updates of the 
touchscreen display CPU. 

2.8 TRIGGER OUTPUT 

The PreMATE+ and HDP-5 have two 3.5 mm trigger sockets on the rear panel. These 
outputs provide a 12 V DC trigger shortly after the DEQX is taken out of standby, and 
can be used to turn on external amplification. 

Both sockets are identical. There are two sockets provided for convenience, as the 
DEQX unit often drives multiple amplifiers.  
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2.9 MEASUREMENT MICROPHONE 

The input connector for the measurement microphone is located between the stereo 
analog input block and the USB Audio input. For information about connecting and 
setting up the measurement microphone, see page 44. When connecting the 
measurement microphone, always double-check that the cable is inserted into the 
correct socket. 

2.10 POWER 

The rear panel contains the AC mains power block: 

 

Mains voltage selector (HDP-4 only) 

The mains voltage selector switch should be set upon delivery to the correct 
voltage for your country. Double-check this before powering on the DEQX for the 
first time. 

IEC mains socket 

This socket accepts a standard IEC (IEC 60320 C13) mains plug. The specified AC 
mains voltage is 100-120 or 220-240 V at 50 to 60 Hz as set by the mains selector 
switch (HDP-4 only), or 1o0 to 240 V at 50 to 60 Hz (all products except HDP-4).  

Power switch 

The power switch applies power to the unit. This is typically left switched on and 
the standby mode invoked from the front panel or with the DEQX Remote. Use 
the power switch to physically remove power from the unit when connecting or 
disconnecting cables or when changing analog gain jumpers (Appendix D). 

Fuse 

The fuse holder uses a standard 5x20 mm glass fuse. In the event that the fuse 
needs to be replaced, it must be rated at 2A for 100–120 V or 1A for 220–240 V. 
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 ANALOG OUTPUT EXAMPLE  

The diagram above illustrates the connections for a pair of full range speakers and a pair 
of stereo subwoofers connected to a PreMATE or PreMATE+. Take the left channel 
speaker output from L2 and the right channel speaker output from R2. Connect the left 
and right subwoofers to L1 and R1 and in DEQX-Cal, set the speaker configuration 
mode to “Single amp with optional stereo subwoofers.” 

If using just one (mono) subwoofer, connect it to L1 and leave R1 unconnected. In that 
case, set the speaker configuration mode in DEQX-Cal to “Single amp with optional 
mono subwoofer.” If not using a subwoofer, simply leave the subwoofer outputs 
disabled when configuring the DEQX in DEQX-Cal. 

For the HDP-4 or HDP-5, the output connections are still taken from L2 and R2 for the 
speakers and from L1 and R1 for the subwoofers. However, the labeling on the rear 
panel is slightly different, as shown below.  

In the case of the PreMATE, PreMATE+, HDP-4 and HDP-5, use the balanced outputs if 
the connected amplifiers or subwoofers have balanced inputs. 

For the HDP-Express II, the connections are as shown above for the HDP-4 and HDP-5, 
but there are no balanced outputs.  
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x 

 DIGITAL OUTPUT EXAMPLE  

The diagram above illustrates the use of the digital output of the PreMATE or 
PreMATE+. Connect the digital output, labeled Full L2/R2, to an external DAC via a BNC 
cable (or an RCA cable with a BNC-RCA adapter). The outputs of the DAC are 
connected to the power amplifier, which in turn drives the left and right speakers. Note 
that the external DAC must be capable of decoding a 24-bit 96 kHz signal. 

If a single (mono) subwoofer is used (as shown above), connect it to the L1 analog 
output (either unbalanced or balanced) and in DEQX-Cal, set the speaker configuration 
mode to “Single amp with optional mono subwoofer.” If stereo subwoofers are used, 
connect them to the L1 and R1 analog outputs (either unbalanced or balanced), and set 
the speaker configuration mode to “single amp with optional stereo subwoofers.” If not 
using a subwoofer, simply leave the subwoofer outputs disabled when configuring the 
DEQX in DEQX-Cal. 

If using an HDP-4 or HDP-5, connect the DAC 
to the Mid/Full L2/R2 digital output (at right).  

With the HDP-4 and HDP-5, an external DAC 
can be used for the subwoofer(s) as well, if 
desired. In that case, connect the digital 
output Low L1/R1 to the DAC being used for 
the subwoofer(s).
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3 THE FRONT PANEL 

The DEQX front panel provides basic controls as well as status and feedback indicators 
for standby, volume control, and profile selection. These are a subset of the controls 
provided by the DEQX Remote (Chapter 4). The PreMATE+ and HDP-5 add an LCD 
touchscreen that provides a volume slider, input and profile selection, real-time 
metering, and other functions.  

 

DEQX PreMATE and HDP-4 — black 

DEQX PreMATE and HDP-4 — silver 

DEQX PreMATE+ and HDP-5 — black 
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3.1 BUTTONS AND INDICATOR LEDS 

There are five sets of buttons and corresponding indicator LEDs on the front panel. The 
standby (I/O) button and indicator is to the left of the panel, while the volume and 
profile selection buttons and indicators are clustered on the right side of the panel. 

Note: the HDP-Express II does not have the buttons on the front panel and relies on the 
DEQX Remote for these operations. The indicator LEDs behave the same way as other 
models. 

3.2 STANDBY 

Press the I/O button to take the DEQX out of or put it into standby mode. The indicator 
LED displays current unit status as shown here: 

 

Standby (red) 

The DEQX is in standby mode. 

Analog/no sync (yellow) 

An analog input is selected, or a digital input is selected and there is no sync signal 
detected. 

Digital sync (green) 

A digital input is selected and digital sync is detected. (Note that the USB Audio 
input will always flag a sync detect even if there is nothing connected to the USB 
Audio input port.) 

Clip (white) 

Clipping was detected on the analog input or on an output channel. The LED 
remains white for several seconds after a clipping event is detected. 
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3.3 PROFILE SELECTION 

The P1, P2 and P3 buttons are used to select a profile. Each profile contains a set of 
correction filters and room EQ, so switching between profiles can be used to audition 
different correction filters and for different listening situations. Use a single button to 
select Profiles 1 to 3 and any two buttons to select Profile 𝟢. 

x PreMATE+ and HDP-5: Press and hold the button or buttons for two seconds. 

x PreMATE, HDP-4, and HDP-Express II: Press the button or buttons and release 
immediately. 

The LEDs light white to indicate the currently selected profile: 

3.4 VOLUME 

Press the up and down buttons to increase or decrease the master volume. The change 
in volume on each button press depends on the current volume setting: 

 
Current volume Volume step size (approx.) 

−24  to  0 dB 1 dB 
−36  t0  −24 dB 2 dB 
−48  t0  −36 dB 3 dB 

−120  t0  −48 dB 6 dB 
 

Below −120 dB, the DEQX is effectively muted. The Volume LED provides an indication 
by color of the volume setting in 10 dB ranges, as illustrated in the diagram below. 
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3.5 TOUCHSCREEN DISPLAY 

The HDP-5 and PreMATE+ incorporate a touchscreen display on the front panel. It 
provides volume control, input and profile selection, real time metering, and other 
functions. 

When turning on the DEQX with the rear panel switch, the touchscreen will remain 
blank for a short period of time while its microprocessor initializes. When taking the 
DEQX out of standby, the touchscreen will come to life almost instantly. 

The touchscreen display turns itself off approximately ten minutes after the last user 
input (use of the display, any front panel buttons or the DEQX Remote), unless the 
metering screen is displayed, in which case it stays illuminated. It turns on again as soon 
as any user input is received. 

Note that the touchscreen display becomes inactive when DEQX-Cal connects to the 
DEQX. When this happens, the volume slider decreases to −∞ (all the way down) and all 
user input on the panel will be ignored. The display will turn itself off after 
approximately ten minutes. 

The master volume slider is present at the left of every screen. Touch the silver bar with 
a finger and slide it up or down to change the master volume. All the way up is 𝟢 dB, or 
maximum volume; all the way down is −∞, or effectively muted. 

Home screen 

The Home screen displays the currently selected input source and profile. Press gently 
on a button to select that input or profile.  

The “Internal” button puts the DEQX (HDP-5 or PreMATE+) into networked streaming 
audio mode, whereby a networked audio source can be streamed to the DEQX for 
playback. See Appendix C for full information on this feature. (This is the same as the 
“Auto” button on the DEQX Remote.) 
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Meters screen 

The Meters screen displays the input signal level on both channels, with three metering 
ranges selectable by the Scale 1, Scale 2, and Scale 3 buttons. The marked values on the 
meter are: 

x −20 to 0 dB for Scale 1 

x −30 to 0 dB for Scale 2 

x −60 to 0 dB for Scale 3 

The meter mimics the “ballistics” of a traditional VU meter, which displays neither peak 
nor average signal but a perceived loudness level. When set to Scale 2, it also mimics 
the amplitude range of a traditional meter. 

 

Note that the touchscreen display does not go to sleep when the Meters screen is 
displayed. 

EQ screen 

The EQ screen is, as of the writing of this version of the DEQX User Manual, still in 
development. 
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Settings screen 

The Settings screen provides two functions: 

Update 

This button updates the touchscreen display firmware. Insert a USB stick 
containing the DEQX-supplied firmware update, and then press the Update 
button. 

Reset 

This button resets the touchscreen display drivers. It can be used on the advice of 
DEQX Support in the event of specific operational issues with the unit. 

 

3.6 SPECIAL STATUS INDICATORS 

The front panel LEDs indicate special status, as follows. 

All LEDs are yellow 

No filter profiles have been loaded into the DEQX. 

All LEDs blinking blue 

The DEQX has been booted into safe mode. See page 167. 

All LEDs turned on in a combination of red, blue and yellow 

The DEQX has entered fault mode. See page 170. 



 31 

4 THE DEQX REMOTE 

The DEQX Remote provides input and profile selection, mute and standby, and volume 
control. In addition, it provides access to the powerful three-band Preference EQ. 
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4.1 PROFILE SELECTION 

Press any of the four buttons to select the corresponding profile. 

The corresponding front panel LED will light white for Profiles 1 to 3. All three LEDs will 
light white for Profile 𝟢. 

4.2 INPUT SELECTION 

All DEQX models have two analog inputs and five digital inputs, all selectable with the 
DEQX Remote. The HDP-5 and PreMATE+ also act as a networked streaming audio 
destination if the “Auto” button is used. 

 
Button Selected input 

A1 Unbalanced analog (RCA) 
A2 Balanced analog (XLR) 
D1 TOSLINK (optical) 
D2 S/PDIF on BNC 
D3 S/PDIF on RCA 
D4 AES/EBU (XLR) 

USB USB Audio input 
Auto HDP-5 and PreMATE+: The DEQX is put into networked streaming audio 

mode (see Appendix C for full details). 

HDP-4, PreMATE, and HDP-Express II: The DEQX plays the last-selected 
digital or analog source, according to which has signal. 

The input selection affects the I/O (standby) LED – see page 26. 
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4.3 VOLUME, MUTE AND STANDBY 

 
Mute  

Mutes all outputs. The Volume LED on the front panel will flash while the DEQX is 
muted (unless the level is below 60 dB, in which case the Volume LED is not lit at 
all). 

Standby 

Takes the DEQX out of standby mode, or puts it into standby mode. In standby 
mode, the I/O LED is red. When out of standby mode, the I/O LED is yellow, 
green, or white (see page 26). In the case of the HDP-5 and PreMATE+, the 
touchscreen becomes active when the DEQX is taken out of standby mode. 

Volume + and – 

Increase or decrease the master volume level. The change in volume on each 
button press depends on the current volume setting: 

 
Current volume Volume step size (approx.) 

−24  to  0 dB 1 dB 
−36  t0  −24 dB 2 dB 
−48  t0  −36 dB 3 dB 

−120  t0  −48 dB 6 dB 
 

Below −120 dB, the DEQX is effectively muted. The Volume LED provides an 
indication by color of the volume setting in 10 dB ranges, as illustrated in the 
diagram below. 
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4.4 PREFERENCE EQ 

The DEQX has three Preference EQ bands, named HIGH, MID, and LOW, that are 
controlled with the DEQX Remote. Preference EQ is used to adjust system response 
with fine-grained frequency shaping to cater for different listening situations and for 
different recordings. Up to 100 Preference EQ presets can be stored in the DEQX and 
recalled with the remote. 

Note that Preference EQ is distinct from room EQ: Preference EQ is stored in the DEQX 
for each profile, but is not stored in the configuration. Loading a new configuration will 
therefore not change Preference EQ settings. 

Referring to the diagram below, the MID band is a fully parametric peaking or cut filter. 
The center frequency is adjustable in semitone steps from 20 Hz to 20 kHz; the gain 
(boost or cut) of the filter can be varied in 1 dB steps between −9 dB and +9 dB; and the 
Q, which controls the width of the filter, can be set from very narrow to very broad. 

The LOW and HIGH bands are shelving filters – that is, low or high frequencies below or 
above the transition frequency are shelved up or down. The transition frequency of the 
filters is settable in semitone steps and the gain (boost or cut) is adjustable in 1 dB steps 
between −9 dB and +9 dB. 
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To set the active EQ band: 

One of the three EQ bands is designated 
“active,” meaning that subsequent changes to 
gain, frequency or Q will act on that band. 

To set the active band, press HIGH, MID, or LOW. 
One of the three profile LEDs, as indicated in 
Table 1 below, will briefly light green to confirm 
the choice. 

(For example, suppose MID is pressed. If the 
DEQX currently has Profile 1 selected, the P1 
LED will go out while P2 lights green, then P2 will 
go out and P1 will turn back on. If, however, the 
DEQX currently has Profile 2 selected, the P2 
LED will change from white to green, then back 
to white.) 

Table 1. Mapping of EQ bands to Profile LEDs 

EQ band Corresponding Profile LED 
LOW P1 
MID P2 

HIGH P3 
 
To change gain: 

Press Gain+ or Gain−. The Profile LED corresponding to the active EQ band will 
briefly light green. The gain of the EQ band will be changed in 1 dB steps, up to 
+9 dB or down to −9 dB. 

 To reset the gain: 

Press Gain 𝟢dB. The Profile LED corresponding to the active EQ band will briefly 
light green. The gain of the EQ band will be set back to 𝟢 dB (flat). 

To change frequency incrementally: 

Press Freq+ or Freq−. The Profile LED corresponding to the active EQ band will 
briefly light green. The corner or center frequency of the EQ band will be changed 
in semitone steps. (That is, the frequency will double or halve after 12 presses.) 
Table 2 shows the default frequencies of each band. 

Table 2. Default frequency and Q 

EQ band Default frequency Default Q 
LOW 110 Hz (F3) — 
MID 440 Hz (F5) 1 octave (Q5) 

HIGH 3.5 kHz (F8) — 
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To change to a specific frequency: 

Press Fx and then a single digit. The Profile LED 
corresponding to the active EQ band will briefly 
light green. The frequency of the active EQ band 
will be changed to the corresponding Quickset 
value printed on the back of the remote control 
and also shown below. 

(Note that to access F10, you can simply press Fx 
and then the digit 𝟢. Pressing Fx, then 1 and then 
𝟢 will have the same effect.) 

To change the MID band Q: 

Press Qx and then a single digit. The Profile LED 
corresponding to the active EQ band will briefly 
light green. If the active EQ band is MID, the Q will 
be changed to the corresponding Quickset value (see below). If the active EQ 
band is LOW or HIGH, there will be no change. 

Quickset values 

The back of the remote contains a key for the Quickset values of frequency and Q:  

 
 Frequency Quicksets 

The nominal audio band of 20 Hz to 20 kHz contains ten octaves. The Quickset 
frequencies are in the (logarithmic) center of each octave band. Thus, F1 is in the 
middle of the lowest octave, and F10 (or F0) is in the middle of the highest octave. 
The frequency quickset will get you instantly into the octave of interest, after 
which you can use Freq+ and Freq− to fine-tune. 

Q Quicksets 

The Quickset values of Q range from narrow to very broad. Q1 has a bandwidth of 
1/12 of an octave, or approximately a single semitone, so will cut or boost a very 
narrow range of frequencies. At the other extreme, Q0 has a bandwidth of four 
octaves, so will cut or boost a sizable portion of the audio band.  
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To save the current EQ settings to a preset: 

Press SAVExx and then two digits. All three 
Profile LEDs will briefly light green. The current 
EQ settings will be stored in the preset given by 
the two digits. (For example, to save to preset 57, 
press SAVExx, then 5, then 7.) 

To recall EQ settings from a preset: 

Press EQxx and then two digits. Provided that EQ 
settings have previously been saved to the given 
preset, those settings will be loaded into the 
current profile. (For example, to recall preset 57, 
press EQxx, then 5, then 7.) 

All three Profile LEDs will briefly light green if the 
recall operation was successful. If there were no 
settings stored in that preset, the LEDs will not 
change. 

To reset the current EQ settings: 

Press EQ Reset. All three Profile LEDs will briefly light green. The three EQ bands 
of the currently selected profile will be reset to their default values. That is: gains 
set to zero, and frequencies and Q set to the values given in Table 2 (page 35). 

 

 

 NOTES ON PREFERENCE EQ  

x Be careful when using boost with EQ, as strong boost can potentially demand a lot 
of additional amplifier power. (3 dB boost requires twice the amplifier power at that 
frequency; 6 dB boost requires four times the amplifier power at that frequency.) At 
low frequencies, boost can potentially cause your speakers to run into excursion 
limits, limiting dynamic range and in extreme cases even causing damage. Always 
listen to the effects of any EQ and “back off” if any distortion is heard. 

x When running a room measurement (Chapter 10), the effects of Preference EQ will 
be included in the room measurement if the “Include parametric filters” option is 
checked. If that is not desired, press EQ Reset first. 

x The Preference EQ will be disabled if any of the profiles currently loaded into the 
DEQX use more than seven EQ bands for Room EQ (Chapter 12). 

x Preference EQ commands are not transmitted over the RS-232 link from master to 
slave units (Chapter 14). 
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4.5 USER MODE 

The User Mode button accesses diagnostic and testing functions built into the DEQX. 
These must be used only on the advice of DEQX Support. 

It is important that you do not attempt to use these functions except on specific advice 
from DEQX Support. Attempting to do so can potentially cause damage to your 
speakers or amplifiers. 

4.6 BATTERY REPLACEMENT 

The remote control takes two AAA size batteries. The battery compartment is at the 
top rear of the remote control. To install the batteries, open the battery cover at the 
back of the remote control by sliding it upward. Install the batteries with + and – signs 
matching the + and – signs in the compartment. 

Replace the cover by sliding it back into place. If the remote control does not work, 
check that the batteries have been installed correctly. 

The batteries will run down over time and with use. Replace both batteries when this 
occurs.
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5 GETTING STARTED WITH DEQX-CAL 

DEQX-Cal™ is a comprehensive measurement, analysis and configuration program that 
interfaces with the DEQX hardware unit.  

5.1 INSTALL THE SOFTWARE 

The main software installer installs both DEQX-Cal™ and the USB driver needed by 
DEQX-Cal to communicate with the DEQX over USB. The software can be installed on 
32-bit and 64-bit versions of Windows from Window XP through to Windows 10. (An 
Apple Mac computer can be used if Boot Camp is used to install and run Windows, or a 
virtual machine emulator such as Parallels or VMWare Fusion is used.) 

To install the software from the provided installation CD, insert the CD into the 
computer’s CD drive. The installer should automatically start. If not, double-click on the 
setup.exe program. Proceed through the steps of the installation and click Finish when 
done. Windows will then complete installation of the USB driver. 

If your computer does not have a CD drive, you can download the latest version of the 
software installer from the DEQX website, at: 

http://deqx.com/upgrades.php  

To install the driver for streaming USB Audio, see Appendix B. This can be done later, 
after you have completed your initial configuration of the DEQX. 

5.2 A TOUR OF DEQX-CAL 

After installation is complete, start DEQX-Cal to familiarize yourself with its layout and 
main features. It can be started by double-clicking the desktop icon, or by selecting it 
from the Windows Start menu. 

http://deqx.com/upgrades.php
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5.2.1 The DEQX-Cal user interface 

The major areas of the DEQX-Cal user interface are shown in the annotated screenshot 
at the bottom of this page. The menus and toolbars shown here and in the rest of this 
manual are the defaults but can be customized if desired (see Chapter 18). 

The main menu bar contains menus for managing projects, windows and wizards, and 
for configuring DEQX-Cal: 

The standard toolbar contains buttons for creating, opening and saving a project. The 
chart toolbar to its right contains buttons that are used to manipulate measurement 
plots – these are described in Chapter 16. 

The wizard toolbar contains buttons that start the various wizards used to perform key 
functions in DEQX-Cal. The wizards are described in following chapters. 

The status bar at the bottom of the window contains context-aware information, such 
as the current location of the cursor on a plot and the status of the DEQX connection.  
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5.2.2 The main display area 

The main display area holds a variety of windows that display controls, measurement 
plots, correction filters, configurations, and so on. These windows are opened as you 
work with DEQX-Cal to measure and calibrate your speakers and room. 

These wIndows can be manipulated with the Maximize, Minimize, Restore and Close 
buttons at their top right (just like regular full-sized windows). Any edge or corner of a 
window can be dragged to resize it. An open window can be quickly brought to the front 
of the display by dropping down the Window menu and selecting it from the list: 

The Window menu contains several other commands that can be used to help with 
arranging windows by cascading or tiling them, and to arrange minimized window icons 
along the bottom of the display area. 
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5.2.3 The Control Panel and IO Manager 

The Control Panel is the real time control interface to the 
DEQX. It is one of the windows in the main display area. To 
open the control panel, click the DEQX Control Panel 
button in the Wizard toolbar, or select it from the Tools 
menu. 

The Control Panel manages the “live” parameters of the DEQX, such as master volume, 
profile selection, input selection, output channel level and delay, and room EQ for each 
profile. (Some of these functions are also accessible from the DEQX Remote.) 

The screenshot below illustrates the main areas of the Control Panel. Other than the 
leftmost master volume and profile selection strip, the display changes according to the 
selected tab at the bottom. 

 

The screenshot below is also annotated with the major areas of the IO Manager tab, 
which is displayed by default and is the tab most commonly viewed. More detail on the 
Control Panel and the IO Manager is provided in Chapter 15. 
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5.3 CREATE A NEW PROJECT 

DEQX-Cal stores all measurements, filters and configuration data in a project. Projects 
can be saved, loaded, or even sent to DEQX if you need assistance from a DEQXpert. 

To create a new project, drop down the File menu and choose “New Project.” Select its 
location in the file system, enter a name, and click OK. Initially, the project is empty. 
Each measurement, calibration, and configuration that you subsequently create 
(Chapters 6 through 10) will automatically be added to the project. 

DEQX-Cal directly supports ongoing and evolutionary 
refinement of your project (or projects, for more advanced 
users). The full overview of the project can be seen in the 
project explorer, accessible from the View menu in the main 
menu bar. (For more information on the project explorer, 
see Chapter 17.) 

 

 

5.4 CONNECT THE DEQX AND POWER IT ON 

Make the necessary input and output audio connections to your DEQX. 
For a single pair of main speakers, with or without subwoofers, the 
output connections are as shown on page 23. 

Connect the PC to the DEQX USB Control port using the supplied USB 
cable. This port is on the lower left of the rear panel, when facing the 
rear panel. 

Connect the DEQX to power, as described on page 22. Turn on the 
DEQX with the rear panel switch, wait a few seconds and then take it out of standby by 
pressing the I/O button on the front panel or the Standby button on the DEQX Remote. 
The status LED will change from red to either yellow or green. 

Wait a few moments. When DEQX-Cal finds the connected DEQX, the status indicator 
in the lower right of the DEQX-Cal window will change: 

If the DEQX Control Panel is open, the status indicator above the master volume slider 
will also change: 
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5.5 SET UP THE MEASUREMENT MICROPHONE 

Accurate measurements are essential for accurate speaker calibration. Each new DEQX 
is supplied with a calibrated measurement microphone in the form of the Standard 
Calibration Kit. An upgraded Reference Calibration Kit is an optional additional 
purchase. Mount the microphone in a suitable stand and connect the XLR-XLR cable 
from the microphone to the Microphone input on the rear panel. 

Each microphone supplied with a DEQX Calibration Kit has a unique calibration file, 
identified by the serial number printed on the microphone. The calibration file must be 
loaded into DEQX-Cal for accurate results. 

Standard Calibration Kit 

Drop down the File menu and select “Install Microphone...” Locate the calibration 
file corresponding to your microphone's serial number on the installation CD and 
open it. (If you are unable to locate the correct calibration file for your 
microphone on your installation CD, check the calibration file downloads at 
http://deqx.com/upgrades.php. If the file is still not found, contact DEQX 
Support.) 

Reference Calibration Kit 

After receiving the Earthworks microphone, contact DEQX Support with its serial 
number in order to receive the DEQX-compatible calibration file. Then drop down 
the File menu and select “Install Microphone...” In the dialog box, locate the 
received calibration file and open it. 

In the IO Manager, go to the Input Select area and click the 
Microphone button to select it as the active input. 

Go to the Microphone Setup area (over to the right of the IO 
Manager), drop down the menu for Correction, and select the 
installed microphone calibration file. Also confirm that the 
Phantom 48V option is enabled (it should be enabled by default). 

Note that DEQX does not recommend or support microphones 
that are not supplied in an authorized DEQX Calibration Kit. 

You can now proceed to perform your first measure-calibrate-
configure cycle (starting in Chapter 6). 

http://deqx.com/upgrades.php
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6 SPEAKER MEASUREMENT 

With the DEQX connected into your system and DEQX-Cal 
running, it is time to measure the speaker. This chapter walks 
you through the first step of the measure-calibrate-configure 
cycle, to measure a full range speaker in a typical listening 
room. It assumes that the DEQX is connected for single-amp speaker configuration 
mode e.g. as on page 23. (For bi-amp and tri-amp configurations, see Chapter 13.) 

One of the vexing issues in speaker measurement is the presence of the room – it is 
difficult to measure only the properties of a speaker, because reflections from any other 
object (including furniture, floor, ceiling and walls) conspire to corrupt the 
measurement. DEQX-Cal is able to remove these reflections from the measurement 
when doing a speaker calibration (described in the next chapter). 

While the reflections can be removed with software, a longer time delay before the first 
reflection arrives at the microphone is still beneficial, because it enables correction to 
lower frequencies. Figure 1 and the description on the next page describe how to 
accomplish this in a typical listening room. Measuring outdoors on a raised platform can 
provide a longer reflection-free time window, but excellent results can still be obtained 
using the method described in this chapter. 

To simplify the explanation, this chapter generally assumes that just one speaker is 
being measured. This is a good choice if you are still becoming familiar with DEQX-Cal, 
as modern hi-fi speakers (of a given model) are quite close to each other in response. 
Once you have mastered the art of measurement and calibration with DEQX-Cal, 
measuring and calibrating both speakers separately will provide the ultimate calibration 
accuracy.  

To obtain accurate speaker measurements, the measurement microphone must be 
pointed directly at the speaker. While it is essentially omnidirectional at lower 
frequencies, it becomes more directional at higher frequencies and is calibrated for a 
flat response at high frequencies only when pointed directly at the speaker. If the 
microphone is pointed vertically at the ceiling or floor, or anywhere but directly at the 
speaker, your measurement (and thus calibration) will not be accurate at high 
frequencies. 
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6.1 SPEAKER AND MICROPHONE POSITIONING 

Figure 1 illustrates a typical indoor speaker measurement setup. A microphone stand 
with a boom arm is recommended for placement flexibility. 

x Move the speaker well away from the walls or other large objects such as furniture. 
(They should be at least as far from the walls as the tweeter is from the floor, 
otherwise those reflections will reduce the reflection-free time window.) 

x If possible, raise the speaker so the tweeter is about halfway between the floor and 
ceiling. This ensures that reflections from the floor and ceiling are as delayed as 
possible. 

x If it is not possible to obtain a sufficiently long reflection-free time window (see 
Chapter 7), place thick absorbing material (e.g. cushions and pillows) on the floor 
between the speaker and microphone to reduce the level of the floor reflection. 

x Position the microphone 600 mm (two feet) away from the speaker. Larger 
speakers may need the microphone positioned further away so the drivers integrate 
properly for the measurement. (Moving the microphone further away will reduce 
the length of the reflection-free time window.) 

x Position the microphone at a height midway between the centers of the midrange 
(or midwoofer) and tweeter drivers. In cases where the tweeter has limited vertical 
dispersion (some types of ribbon tweeters, for example), positioning the 
microphone at the same height as the tweeter center may be more accurate. 

x While the microphone is typically positioned horizontally on the speaker’s axis, in 
some cases a better measurement can be obtained if the microphone is slightly off 
the horizontal axis (such as inline with the edge of the speaker cabinet). 

Figure 1. Speaker measurement setup 
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6.2 START THE SPEAKER MEASUREMENT WIZARD 

If you do not already have a project open, open an existing project or create a new one. 

Start the speaker measurement wizard by clicking on the 
Measure Speakers button in the Wizard toolbar or by 
selecting it from the Tools menu. 

The wizard will take you through a series of screens. To proceed through them, select 
the necessary options on each screen and click the Next button. If you realize you've 
made a mistake or need to check what you've done, click the Back button to go back 
through the screens already visited. 

Screen 1. If you have more than one project open (page 149), this screen is used to 
select the project in which the measurement will be stored. Otherwise, this is just an 
informational screen. 

Screen 2. Create a new measurement, or select an existing measurement to open. (The 
following steps assume that you have selected “Create a new speaker measurement.”) 

6.3 SET SPEAKER MEASUREMENT PARAMETERS 

Screen 3. This screen sets a number of parameters that control the measurement. (See 
next page for descriptions.)  
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Manufacturer 

Enter the manufacturer of the speaker. This is used to help organize 
measurements within the project. The drop-down selector can be used to select 
from manufacturers that were previously entered. 

Model 

Enter the model of the speaker. This is used to help organize measurements 
within the project. The drop-down selector can be used to select from models 
that were previously entered. 

Configuration 

To measure a single speaker (or a pair of speakers), select 
“Single amp” from the drop-down menu. (The following 
steps assume that you have selected “Single amp” here. 
See Chapter 8 for the “Subwoofer” option and Chapter 13 
for the “Bi amp” and “Tri amp” options.) 

96k Measurement 

If this box is checked, the DEQX runs the measurement at a 96 kHz sample rate. 
This is recommended for all current DEQX products. If the box is unchecked, the 
DEQX runs the measurement at a 48 kHz sample rate. 

Source 

This option selects from one of several sweep lengths. At 
right are the choices for a 96 kHz measurement, showing 
sweep lengths from 0.3 to 2.4 seconds. Longer sweeps 
give higher resolution measurements. 

Average over 

Averaging multiple measurement sweeps will improve 
the signal-to-noise ratio of the measurement. DEQX 
recommends a minimum of 9 sweeps to guard against 
noise corrupting the measurement. If you have trouble 
obtaining a high confidence level (page 51) in the 
measurement, redo the measurement with a higher 
number of sweeps. 

Measurement Name 

Enter a name that characterizes this measurement. This name is used for 
informational purposes and will help you to navigate the project later on. 
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Measurement Details 

Enter the dimensional information about the measurement: the distance of the 
microphone from the speaker, the angle of the microphone relative to the 
speaker axis in the horizontal direction (this should be zero for this 
measurement), and the height of the microphone. 

The information entered here is used by DEQX-Cal to calculate the initial length 
of the speaker calibration time window (page 56). 

Skip level setting page 

If this box is checked, the level-setting screen (Screen 6, page 50) will not be 
displayed. Check this box only if you have previously set the measurement levels. 
If in any doubt, leave this box unchecked. 

6.4 SELECT THE SPEAKER TO BE MEASURED 

Screen 4. Enter the serial number of the speaker being measured. (While this field 
doesn't have to be the speaker's serial number, we recommend that it be set correctly in 
order to assist in identifying measurements later.) The drop-down selector can be used 
to select from serial numbers that were previously entered. 

 

Screen 5. Select either the left or right main speaker by clicking on its icon.  

If this is the first measurement, this is a good time to confirm that you have made your 
output connections to the rear panel correctly, as indicated in the “Connections” list on 
the left. 

Click Next to continue. 
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6.5 SET THE MEASUREMENT SIGNAL LEVEL 

Screen 6. DEQX-Cal will upload the test signal to the DEQX, as shown by the 
“Initializing DEQX” indicator. 

When the screen switches to the “Playing test signal” indicator, switch to the IO 
Manager to view the meters. (Click the Show Meters button if it is not visible.) 

1. Confirm that the DEQX is not muted. (Click the Unmute button if it is.) 

2. Confirm that the microphone is selected as the input source. 

3. Raise the output level slider slightly. 

4. Confirm output signal on the L2 or R2 output. You should hear a frequency sweep 
test tone at low volume from the speaker being measured. 

5. Raise the output level slider slowly until the test tone is moderately loud and the 
microphone input level is peaking in the range of 90–95 dB. 

To proceed, go back to the measurement wizard and click Run. 
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6.6 RUN THE SPEAKER MEASUREMENT 

Screen 7. DEQX-Cal runs through a series of steps to measure the speaker. 

 

1. “Initializing measurement” uploads the measurement signal to the DEQX. 

2. “Running measurement” executes the measurement sweeps at the level set on 
Screen 6. The number of sweeps will be as set in the “Average over” parameter on 
Screen 3, plus one. (The first sweep is used by the DEQX to calibrate itself internally. 
The remaining sweeps are the ones used to determine the speaker response.) 

3. “Retrieving data” transfers the captured measurement data from the DEQX to 
DEQX-Cal running on the computer. 

4. “Calculating impulse response” displays while DEQX-Cal calculates the impulse 
response based on the measurement data. All subsequent measurement plots are 
derived from the calculated impulse response. 

When the impulse response has been calculated, the wizard displays the confidence 
level of the measurement. The confidence level indicates the quality of the 
measurement – the higher, the better. It is related to signal-to-noise ratio but takes 
additional factors into account, such as distortion anywhere in the signal chain and 
whether room reverberation has died off before the next measurement cycle begins. 

For a speaker measurement, the confidence level should always be greater than 20 dB. 
If it is not, you will need to retry the measurement (see next page). Increasing the 
number of sweeps, increasing the sweep length, reducing background noise, and 
increasing the signal level (but not so far as to introduce distortion) are all ways to 
improve the confidence level of the measurement. 
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6.7 COMPLETE THE MEASUREMENT 

Screen 8. When the measurement is completed, a thumbnail of the measured 
frequency response is displayed. Most of the time, you will simply click Accept. If you 
think there is an error in the measurement (for example, there was unexpected external 
noise or the confidence level is low), click Retry to run the measurement again.  

 

Screen 9. This is the exit screen. 

To proceed directly to speaker calibration, leave the option “Calibrate Measurement” 
selected and click Finish. This is a convenience feature that will take you directly to the 
calibration wizard (next chapter) with the measurement just taken already pre-selected 
for calibration. 

Or, if you want to measure the other speaker, move the microphone to the correct 
position for measuring it, then click More. You will be taken back to Screen 4. (The level 
setting screen will be bypassed when taking the second measurement.)  

Otherwise, choose one of the remaining options and click Finish: 

Close the wizard normally 

The wizard will close without opening the measurement just taken. 

Display the results in: 

Choose “New Viewer” to open a new data viewer. Or, select an open data viewer 
from the drop-down menu to display the measurement in that viewer. (The 
viewer will appear as shown on page 141.) 
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7 SPEAKER CALIBRATION 

To calibrate the speaker means to correct its anechoic 
amplitude and phase response – that is, without the effects of 
the room. This is the second step of the measure-calibrate-
configure cycle. DEQX-Cal will use the speaker measurement 
or measurements taken earlier to generate these filters, via 
the use of calibration templates. 

A calibration template is the container for sets of correction filters. When a calibration 
template is created, one or more measurements are selected as “input.” Various 
parameters are then specified in order to create a correction set, which contains one 
correction filter per “input” measurement. 

More correction sets can be created from the same measurements, but with different 
parameters. These can be loaded into different profiles (see Chapter 9) to audition the 
effect of the different parameters. 

This chapter explains how to create a calibration template and generate correction sets 
for the single-amp speaker configuration modes. To keep the presentation simple, the 
examples show a single measurement being used for both speakers. Once you are more 
familiar with DEQX-Cal, you can use a separate measurement for each speaker. (For bi-
amp and tri-amp speaker configuration modes, see Chapter 13.) 
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7.1 CREATE A CALIBRATION TEMPLATE 

The calibration wizard can be entered directly from the last 
screen of the speaker measurement wizard (page 52). Or, 
start the calibration wizard by clicking on the Calibrate 
Speakers button in the Wizard toolbar or by selecting it from the Tools menu. If 
entering directly from the speaker measurement wizard, Screens 2 and 3 below will not 
be displayed. 

The calibration wizard will take you through a series of screens. Select the necessary 
options on each screen and click the Next button. If you realize you've made a mistake 
or need to check what you've done, click the Back button. 

Screen 1. If you have more than one project open (page 149), this screen is used to 
select the project in which the calibration will be done. Otherwise, this is just an 
informational screen. 

Screen 2. Create a new calibration template, or 
select an existing calibration template to open. 
(The following steps assume that you have 
selected “Create a new speaker calibration.”) 

Screen 3. Select the “Single amp” speaker configuration mode. (See Chapter 8 for the 
“Subwoofer” option and Chapter 13 for the “Bi amp” and “Tri amp” options.) 

Screen 4. Select or confirm the measurement that will be used to create the correction 
set. (If you measured both speakers, select both of those measurements here.) Only 
measurements that match the chosen configuration can be selected. (You cannot, for 
example, calibrate a speaker with a subwoofer measurement.) 

Screen 4a. If you have selected only one measurement, you will be given a warning. 
Click Next to proceed. 
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Screen 5. Enter the name of the calibration template. 

Screen 6. You will be presented with a summary of the template parameters: 

Click Finish to proceed. 

On completing the wizard, a new calibration template opens, as shown in the 
annotated screenshot below. Above the plot is a wizard-like set of buttons used to 
proceed through the steps of creating a correction set. Note also the row of navigation 
tabs along the bottom – these can be used as an alternate navigation method to the 
wizard-like Back/Next buttons. 

The plot selector at the bottom lists the various plots shown in the plot display area and 
enables them to be turned off and on. (For more operations on plots, such as zooming, 
refer to Chapter 16.) 
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7.2 SET THE IMPULSE RESPONSE TIME WINDOW 

Screen 1 / Anechoic tab. This tab shows the measured time domain impulse response of 
the speaker and the room. It is used to set a time “window” on the impulse response to 
exclude room reflections, thus obtaining the anechoic response of the speaker alone. 

The time window is shown as a shaded area to the left side of the plot, with a vertical 
green bar marking its end (see the example below). When the calibration template 
opens, the end of the window is set automatically based on the distance parameters 
entered when the measurement was taken (page 47). To adjust it manually, click on and 
drag the vertical green bar. Ideally, it should be positioned just before the first major 
reflection, as shown below. (You may find this easier if you zoom in on the plot using 
the “+” zoom icon in the toolbar.) A high quality measurement will have no significant 
reflections before the first major room-related reflection. 

You can also set the end of the time window 
by double-clicking on the vertical bar to 
open the dialog box shown at right. Change 
only the higher limit (the lower text box) and 
leave the lower limit (the upper text box) set 
at 𝟢. (Ignore the Max Boost and Max Cut 
parameters, as they cannot be set here.) 

 

The effective length of the time window is the time difference between the impulse 
response peak and the vertical bar. In the example below, the impulse response peak 
occurs at 5.7 ms and the bar is set at 11.2 ms. Therefore, the effective window length is 
(11.2 – 5.7) = 5.5 ms. The effective window length determines the frequency resolution 
and thus the lowest correction frequency, as given by Table 3 on page 58. 
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7.3 SET SMOOTHING 

Screen 2 / Smoothed Measurements tab. This tab shows the frequency response 
corresponding to the impulse response time window. The adjustment on this tab is the 
smoothing applied to the frequency response plot: 

Smoothing is used to compensate for unwanted reflections in the speaker 
measurement. While the time window is used to remove the major reflections, other 
reflections and noise may still be present within the window (such as from the edges of 
the speaker or from the speaker stand). 𝟢% smoothing can be used if the time window 
is completely free of reflections, but up to 100% may be required if there are reflections 
present. As a general rule, it is best to start with 100% smoothing, and then experiment 
with and audition additional correction filters with less smoothing. 

In some cases, such as larger speakers that cannot be moved or raised, the reflection-
free time window may not be as long as desired. One option is simply to raise the lower 
frequency correction limit (next page). Another is to use damping material on the floor 
when measuring, set the end of the time window past the location of the (damped) 
floor reflection, and set smoothing to 100%. (Consult your DEQXpert for advice on this.) 

Note that the plot falls off at low frequencies. Below the lower correction limit (see 
Table 3 on the next page), the displayed measurement is not valid. This is not the actual 
response of the speaker, but an unavoidable artifact of the short impulse response time 
window. A more accurate response to lower frequencies will require a longer window. 

Click Next to proceed. 
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7.4 SET THE CORRECTION FREQUENCY LIMITS 

Screen 3 / Limits tab. The blue rectangle on this tab sets the correction frequency 
region and its cut and boost limits. The rectangle can be altered by clicking and 
dragging on any of its edges. The predicted response (shown in red by default) will 
change as the edges are moved. 
x The left edge sets the lower frequency limit . Set this edge using Table 3 below as a 

guide. Do not set the limit any lower than suggested in Table 3, as your calibration will 
be incorrect if you do so. 

 

Table 3. Lower frequency limit vs window length 

Effective window length Low frequency limit 
4 ms 300–400 Hz 
8 ms 150–200 Hz 

12 ms 100–150 Hz 
 

x The right edge sets the upper frequency limit. Set it at or close to a frequency where 
the plot crosses the 𝟢 dB line (in order to minimize abrupt changes in the correction 
filter). A frequency between 5 and 10 kHz is often a good choice, as this allows the 
tweeter to keep its own character at the extreme high frequencies while providing 
accurate calibration across the midrange and most of the treble. Alternatively, set 
the upper frequency near or above 20 kHz to fully correct the speaker’s response. 

x The top and bottom edges set the maximum cut and boost (respectively) of the 
correction filter. Move the top edge down toward 𝟢 dB to limit the amount of cut, 
and move the bottom edge up toward 𝟢 dB to limit the amount of boost. When the 
edge intersects the plot, the amount of cut or boost will be reduced and the 
predicted response plot will change accordingly. 
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You can also double-click on the limits 
rectangle to bring up a dialog box that allows 
you to enter the limits directly (shown at 
right). As a general rule, increasing Max 
Boost beyond the default of 6 dB is not 
recommended. 

 
 

Above the plot area is a checkbox to enable automatic rescale 
of the plot. If checked, the graph is automatically adjusted 
vertically so that the left edge of the limit box is at 𝟢 dB. If unchecked, the scale value 
can be set manually (in the example below, it is set to −2.0 dB). If in any doubt as to the 
behavior of this option, it is best to leave it unchecked. 

 

In some cases, you may require different maximum cut and boost limits in different 
frequency ranges. This is usually required only by advanced users, such as when using 
an in-room measurement as the basis for speaker correction (page 121). 

To set up multiple limit regions: 

1. Click the Add Point button in the chart toolbar. 

2. Click in the plot area between the left and right edges of the limit box. A dashed 
vertical line will appear. 

3. Click and drag the edges and dashed line(s) to change the limits. 

Once the frequency limits have been set to your satisfaction, click Finish to proceed. 
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7.5 SET CORRECTION PARAMETERS 

Screen 4. DEQX-Cal will ask you to confirm parameters that set how tightly it attempts 
to correct for amplitude and group delay: 

 

Max Delay 

Sets the maximum delay that can be introduced by the correction filter. If using 
the DEQX with video, the default of 3 ms is recommended in order to avoid 
introducing video sync errors. Otherwise, this parameter can be increased if 
desired, up to the maximum of 24 ms (in the single amp configuration modes). 
See the tip box on page 79 for more information on delays. 

Step response correction 

Check this option for speakers, and uncheck it for subwoofers. If this option is 
checked and the correction algorithm fails to complete, uncheck it and try again. 

Group delay tolerance 

Sets the target group delay variation of the corrected speaker. The default value 
represents a tight tolerance that will usually succeed. This can be set tighter than 
the default, although the algorithm may not always succeed. 

Magnitude tolerance 

Sets the target magnitude variation of the corrected speaker. The default value 
represents a tight tolerance that will usually succeed. This can be set tighter than 
the default, although the algorithm may not always succeed. 

Name of the new correction set 

If “Create a new correction set” is selected, provide a name for it here. The default 
is “Correction set 1” and so on, but a more meaningful name will help with 
navigating the project later. (The option “Overwrite previous correction set” 
becomes available on subsequent runs.) 
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7.6 GENERATE THE CORRECTION SET 

Screen 5. After completing the correction parameters, a progress window appears that 
shows the steps of the correction algorithm and a progress bar. Typically, the algorithm 
will take less than a minute to run. 

After calculation completes, click Finish. 

Screen 6 / Correction set tab. The calibration template will create a new tab displaying 
the correction filters. In the example below, there is a single filter in the correction set 
(the correction filter is in green and the predicted response is in purple). 

Note that the predicted response includes the effect of the impulse response time 
window (as set on the Anechoic tab). There is therefore a visible fall-off at low 
frequencies, below the frequency given by Table 3 on page 58. Once again, this is not 
real – the fall-off is an artifact of the short time window.  

To proceed directly to configuration (Chapter 9), 
click the Configure DEQX button to the top left 
of this tab. Or, to create additional correction 
sets, read the following pages. 
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7.7 VERIFY THE CORRECTION FILTER 

The DEQX has the ability to immediately take a verification 
measurement on a correction filter without having to first 
configure the DEQX and upload the correction filter to it. To start a verification 
measurement, go to the correction set tab that you wish to verify and click the Verify 
Results button. 

Screen 1. The first screen is an informational screen.  

Screen 2. Confirm the correction filter to be verified and the measurement parameters: 

Screens 3 to 6. Proceed through the measurement in the same way as described for the 
initial measurement (pages 49 to 52). When the measurement is complete, click Finish. 
A new data viewer will open with the measured response that includes the effect of the 
correction filter, as shown in this example (note that the time window is still in place): 

Note also that verification measurements are not saved in the project. 

To compare the verification measurement to the original measurement, locate the 
original measurement in the project explorer, and drag and drop it onto this data 
viewer. 
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7.8 CREATING ADDITIONAL CORRECTION SETS 

A calibration template can hold any number of correction sets, which differ in the 
length of the correction time window, smoothing, correction frequency limits, and 
correction parameters. To create another correction set: 

1. Click on the Anechoic tab. Adjust the time window if desired. 

2. Click on the Smoothed Measurements tab, or on Next. Adjust the smoothing. 

3. Click on the Limits tab, or on Next. Adjust the correction filter limits. 

4. Click on Finish. You can either overwrite the most recently generated correction 
set, or select the option “Create a new correction set” and enter a name for it. On 
this screen, you can also change parameters such as Max Delay.  

5. Proceed through the remaining screens to generate the new correction set. 
 

 RENAMING CORRECTION FILTERS  

While DEQX-Cal allows you to name the correction set when generating filters, the 
names of the individual correction filters are still automatically generated (“Correction 
Filter 1” and so on). Once you have generated a few different correction filters, this can 
make selecting the correct filter for configuration (Chapter 9) more difficult. 

Therefore, use the project explorer to navigate to the individual filters, right-click, and 
select “Rename.” Use the same name as the template, and indicate which speaker is 
which. For example, here we have used “280 to 8200 Hz - Left spkr.” 
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7.9 TO RE-OPEN A CALIBRATION TEMPLATE 

Calibration templates are stored in the project file. Any edits to a calibration template 
are saved when the project is saved. 

There are two ways to open an existing calibration template for viewing: 

1. By using the calibration wizard. Click the Calibrate Speakers button and on 
Screen 2, select the option “Load an existing speaker calibration.” In the pane 
underneath, select the calibration template that you wish to load. Then click Finish. 

 

2. From the project explorer. Unfold the CALIBRATION TEMPLATES folder, right-click 
on the calibration template that you wish to open, and select “Open” from the 
popup menu. (If this entry is greyed out, the template is already open and you can 
bring it to the front from the Window menu.) 

 
The popup menu can also be used to rename and delete a calibration template (see 
page 148). 
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8 SUBWOOFER MEASUREMENT AND 

CALIBRATION 

The approach taken to measure and calibrate subwoofers is different than for speakers. 
Instead of using windowing, a nearfield measurement is taken so that the direct sound 
from the subwoofer dominates the room effects. 

(See page 121 for an alternative but more advanced approach to low-frequency 
measurement that can be used with subwoofers.) 

If you are not using subwoofers, skip this chapter. 

8.1 MEASURE THE SUBWOOFER  

The diagram below illustrates how a subwoofer is measured. The subwoofer should be 
measured in its intended location. Position the microphone 5 to 20 cm (2 to 8 inches) 
from the subwoofer cone. 

Set the controls on the subwoofer for minimum processing: disable its low pass filter 
(crossover) if possible, or if not, set it to its highest frequency; turn off any equalization 
in the sub; and set any phase or invert controls to their neutral positions.  

Figure 2. Subwoofer measurement setup 
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Once the microphone is in place, follow the measurement procedure given for speakers 
(starting on page 47), but with the following specific differences. 

Screen 3. Select “Subwoofer” for the Configuration parameter. For Source, select the 
longest sweep available. 

Screen 5. Select the subwoofer being measured. If using stereo subwoofers and both 
subwoofers are identical, there is no need to measure both of them. If they are not 
identical, then you will need to measure both. 

Screen 6. For a nearfield subwoofer measurement, measurement levels can peak in the 
100 to 110 dB range. 

Screen 9. Select “Calibrate Measurement” and click Finish to jump directly to the 
calibration wizard, or click More to measure a second subwoofer.  
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8.2 CALIBRATE THE SUBWOOFER 

To calibrate the subwoofer, follow the procedure given for speakers in Chapter 7, but 
with the following specific differences. 

Screen 3. If you did not jump directly from the measurement wizard to the calibration 
wizard, select “Subwoofer” for the Speaker Config parameter. 

Screen 4. Select or confirm the measurement to use for subwoofer calibration (DEQX-
Cal will only list measurements here that were taken with the Configuration parameter 
in the speaker measurement wizard set to “Subwoofer”): 

(If you are using stereo subwoofers and you measured both of them, select both 
measurements here.) 

Anechoic tab. Set the end of the correction time window at a fairly high value, like 100 
ms. Or double-click on the vertical green bar and enter 170 ms (the maximum). 

 

Smoothing tab. Set smoothing to 100%. (Less smoothing can be trialed and auditioned 
later if desired.) 
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Limits tab. Set the frequency range so that the subwoofer extends from its lowest 
useful frequency to significantly past the intended crossover frequency. This example 
uses a frequency range from 25 Hz to 250 Hz:  

 

The frequency range limits may be easier to set if the Auto rescale option is turned off. 

It is important to be realistic with subwoofer equalization. At the low end of their range, 
all speaker drivers can be pushed into excessive distortion if correction is not applied in 
a manner that is within the driver’s capabilities. Set the lower limit at a frequency that is 
realistic for your subwoofer(s) and listening levels. 

Click Finish to initiate generation of the subwoofer correction filters. On the 
parameters screen, be sure to turn step response correction off:  

After completing the calibration, a verification measurement can be used to confirm the 
effect of the correction filter:
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9 CONFIGURING THE DEQX 

In order for the DEQX to execute speaker correction, it needs to be 
told which correction filters to use. This is the third step of the 
measure-calibrate-configure cycle. This chapter will show you how to 
configure the DEQX with speaker and subwoofer correction filters and 
set things up for room measurement and correction later on. 

9.1 WHAT IS A CONFIGURATION? 

A configuration is a set of data that is created in DEQX-Cal and then uploaded to the 
DEQX to control its audio processing. It consists of: 

1. The speaker configuration mode – single amp with optional mono subwoofer, 
single amp with optional stereo subwoofers, bi-amp with optional mono 
subwoofer, bi-amp with optional stereo subwoofers, or tri-amp. 

2. Four profiles, each of which contains: 

a. A correction/crossover filter for each speaker, subwoofer, or driver; 

b. Limit filters for each speaker or subwoofer; 

c. Individual gain and delay settings for each speaker or subwoofer; 

d. Individual polarity settings for each speaker, subwoofer, or driver; and 

e. Parametric EQ for room correction. 

Once the configuration has been uploaded to the DEQX, the four profiles make it easy 
to audition different speaker correction filters and room EQ filters simply by pressing a 
button on the DEQX Remote. The correction filters may have different settings such as 
the amount of smoothing, correction frequency range, crossover slope, and so on. 

A configuration is stored on the computer (in the project file). Advanced users can 
create multiple configurations if desired and upload them to their DEQX at different 
times. Note that uploading a configuration does not change any of the “live” 
parameters set in the IO Manager (pages 130 to 133). 
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9.2 CREATE A CONFIGURATION 

Start the configuration wizard by clicking on the Configure button in 
the Wizard toolbar or by selecting “Configure DEQX” from the Tools 
menu. 

The wizard will take you through a series of screens. To proceed through them, select 
the necessary options on each screen and click the Next button. If you realize you've 
made a mistake or need to check what you've done, click the Back button to go back 
through the screens. 

Screen 1. If you have more than one project open (page 149), this screen is used to 
select the project in which the configuration will be created. Otherwise, this is just an 
informational screen. 

Screen 2. You can create a new configuration, or select an existing configuration to 
view and modify. (The following steps assume that you have selected “Create a new 
DEQX configuration.”) 

Screen 3. Name the configuration, and select the speaker configuration mode. There 
are five modes to choose from, depending on the exact way in which you are deploying 
your DEQX. 

The rest of this chapter assumes that you have chosen either “Single-amp with optional 
mono subwoofer” or “Single-amp with optional stereo subwoofers.” (For bi-amp and 
tri-amp modes, see Chapter 13.) 

Note that the speaker configuration mode is the same for all four profiles. If you want to 
experiment with, for example, using both a mono subwoofer and using stereo 
subwoofers, you will need to create separate configurations. 

Screen 4. This is a confirmation screen. Click Finish to proceed. The wizard will close 
and DEQX-Cal will open a new configuration window. 
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9.3 THE CONFIGURATION WINDOW 

The configuration window contains a diagrammatic representation of the speakers, 
with either one or two subwoofers. By default, all speakers in each profile of a new 
configuration are disabled, as indicated by the labels “Left - (Disabled)” and so on. 

At the top of the window is a toolbar containing a set of important controls. (While you 
are becoming familiar with them, you may prefer to turn on text labels. To do so, see 
page 158.) From left to right: 

Profile selection 

These buttons set the profile currently being 
displayed or edited.  

Check this selection every time you edit a configuration, to avoid changing the 
wrong profile. To make these buttons more prominent, you can enable text labels 
for the toolbar – see page 158. 

 RENAMING PROFILES  

The profile name displayed in the 
window can be changed by 
renaming the profile, so that e.g. 
“Profile 1” in the screenshot above 
is replaced with a meaningful name. 
Do this in the project explorer: 
navigate to the configuration, right-
click on the profile, and select 
“Rename” from the pop-up menu. 
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Speaker configuration mode 

This drop-down selector sets the speaker 
configuration mode for all profiles in this 
configuration. It is initially set to the value chosen in 
the configuration wizard. While it can be changed 
later, some configuration data may be lost. 

Sample rate 

This drop-down selector sets the sample rate at which this 
configuration operates. The 48 kHz option is to support 
legacy DEQX products only. For current generation DEQX 
products, always leave this set to 96 kHz. 

Refresh Filters 

This button updates the correction filters. Use it if any of the 
filters have been changed in the calibration template, or 
whenever viewing the Filters tab. 

Save All to DEQX 

This button uploads all profiles in the configuration to 
the connected DEQX. See page 79. 

Read EQ from DEQX 

This button reads room EQ settings for all profiles 
from the DEQX into the configuration. See page 102. 

Open Template 

This button opens the calibration template that created the correction 
filters loaded into the selected profile. If no filters have been loaded, 
this button is greyed out; if the filters have been loaded from a single 
calibration template, it will be opened; if the filters have been loaded from more 
than one calibration template, a dialog will allow you to select which to open: 

The three tabs at the bottom of the window select the content to be displayed in the 
main area. In most of this chapter, the Configuration tab is assumed to be selected. The 
Equalizer tab is described on page 102 and the Filters tab on pages 76 and 78. 
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9.4 THE FILTER PROPERTIES DIALOG 

The filtering applied to each individual speaker is set in its Filter Properties dialog, 
opened by double-clicking on the speaker (or subwoofer) icon. It contains four tabs: 

 

9.4.1 Main Filter tab 

This tab selects the main correction filter (if any). There are four options: 

 

Use a correction filter for this loudspeaker 

Select this option if you have generated a correction filter for the speaker. A pane 
will open underneath, from which you can select the correction filter: 

 

(In this example screenshot, the correction filters have been made easier to find 
by renaming them during calibration, as described in the tip box on page 63.) 

Note that the selection pane will only show filters that match the speaker and the 
speaker configuration mode. You cannot, for example, load a filter generated for 
a subwoofer into a speaker, or a filter generated from a bi-amp measurement into 
a single-amp configuration. 

You can also select a correction filter by navigating to it in the project explorer 
and then dragging and dropping it onto the speaker (or subwoofer) icon. 
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Use a crossover filter for this loudspeaker only 

This option is available only in the bi-amp and tri-amp speaker configuration 
modes. See page 122. 

Bypass correction for this loudspeaker, but still use limit filters 

The speaker output is enabled but no correction will be applied to it. You can still 
set limit filters (high pass and low pass filters) on the Limits Filters tab. 

Disable the processor outputs for this loudspeaker  

This is the default setting. The corresponding speaker output is disabled.  

9.4.2 Limit Filters tab 

This tab sets the limit filter parameters. There are two filters: low pass (aka high cut) 
and high pass (aka low cut). By default, both filters are disabled. 

See page 77 for information on how to use limits filters for a subwoofer crossover, and 
pages 118 and 119 for information on how to use limit filters for the woofer-mid 
crossover in a three-way active speaker. 

9.4.3 Time/Level tab 

This tab is used to set a delay on the speaker (or subwoofer) and to adjust its level. It is 
typically used for subwoofer integration (Chapter 11). 

9.4.4 Advanced tab 

In single-amp mode, this tab can be used to invert the polarity of the speaker (or 
subwoofer). In some cases, this can help with subwoofer integration. It can also be used 
to correct for absolute phase with some types of amplification. 

In bi-amp and tri-amp modes, this tab contains additional options – see page 124. 
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 COPY FILTER SETTINGS BETWEEN SPEAKERS  
To copy filter settings from one speaker to another, you can use drag and drop. For 
example, to copy the filter settings from the left speaker to the right speaker: 

1. Click on the left speaker icon (but don’t release the mouse button). It will be 
highlighted in a grey outline. 

2. Drag the mouse over to the right speaker. 

3. Release the mouse button. 

To copy filter settings between different profiles, use copy-and-paste operations. For 
example, to copy settings from Profile 𝟣 to Profile 𝟤: 

1. Click on the Profile 𝟣 selector.  

2. Right-click on the speaker from which you wish to 
copy filter settings and select “Copy” from the popup 
menu. 

3. Click on the Profile 𝟤 selector.  

4. Right-click on the same speaker in this profile and 
select “Paste” from the popup menu. 

After copying settings, visually check the configuration to 
confirm that the data has been copied. 

9.5 CREATE A PROFILE WITH NO CORRECTION 

This example profile will be set up to play audio to a pair of main speakers, with no 
correction filters applied.  

1. Select Profile 𝟢 from the toolbar:3 

2. Open the Filter Properties dialog of the left speaker. 

3. On the Main Filter tab, select “Bypass correction for this loudspeaker, but still use 
limit filters.” 

4. Repeat steps 2 and 3 for the right speaker. Alternatively, just copy the filter settings 
from the left speaker to the right speaker, as described in the tip box above. 

                                                                    
3 For historical reasons, Profile 𝟢 is sometimes referred to as “Bypass.” It is, however, identical to 
the other three profiles and can contain correction and limit filters and delay and gain settings. In 
the buttons at the top of the configuration window, select Profile 𝟢 by pressing the “B” button. 
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9.6 CREATE A CORRECTION PROFILE 

This example profile will be set up to play audio to a pair of main speakers, with 
correction filters applied. 

1. Select Profile 1 from the toolbar: 

2. Open the Filter Properties dialog of the left speaker. 

3. On the Main Filter tab, select “Use a correction filter for this loudspeaker.” In the 
pane that opens underneath, select the desired correction filter (page 73). 

4. Repeat steps 2 and 3 for the right speaker. Alternatively, if you are using the same 
correction filter for both speakers, copy the filter settings from the left speaker to 
the right speaker as described in the tip box on page 75. 

After closing the dialog, the configuration tab will overlay the speaker icons with 
information about the filters that have been set up. For example: 

 
 

The filters can also be viewed graphically on the Filters tab (use the Refresh 
Filters button to ensure that you are seeing the current filters): 
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9.7 ADD A SUBWOOFER OR SUBWOOFERS 

If you are using a subwoofer or subwoofers, add limit filters to implement a crossover 
between the subwoofer and the main speakers. (The following steps assume that 
Profile 𝟢 and Profile 1 have been set up as described on the previous two pages.) 

1. Select Profile 𝟢 from the toolbar: 

2. Open the Filter Properties dialog of the subwoofer (or the left subwoofer if using 
stereo subwoofers) and select the Limit Filters tab. 

3. Enable the checkbox labeled “Low pass filter” and then set the desired filter type, 
frequency and slope parameters. Typically, this is a Linkwitz-Riley filter between 80 
and 120 Hz with a 24 or 48 dB/octave slope: 

4. Close the dialog box. If using stereo subwoofers, repeat for the right subwoofer. 

5. Open the Filter Properties dialog of the left speaker and select the Limit Filters tab. 

6. Enable the checkbox labeled “High pass filter” and then set the desired filter type, 
frequency and slope parameters. As a starting point, use the same values used for 
the low pass filter: 

7. Close the dialog box and repeat for the right speaker. 

The speaker and subwoofer icons will display the limit filters: 
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Profile 1 must be set up in the same way, but with the correction filter for the 
subwoofer added. 

1. Select Profile 1 from the toolbar: 

2. Set up limit filters as described on the previous page. 

3. Open the Filter Properties dialog box of the subwoofer (or the left subwoofer if 
using stereo subwoofers). 

4. On the Main Filter tab, select “Use a correction filter for this loudspeaker,” and 
select the subwoofer correction filter in the pane that opens underneath: 

5. Close the dialog. If using stereo subwoofers, repeat for the right subwoofer. 

The speaker and subwoofer icons on the Configuration tab will update to display the 
correction and limit filters. 

To graphically confirm the effect of these filters, view the Filters tab. The displayed 
plots will show the combined effect of the correction and limit filters, as shown here: 

 

 

When viewing this tab, click the Refresh Filters button to ensure that you are 
seeing the latest version of the filters. 
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9.8 UPLOAD THE CONFIGURATION TO THE DEQX 

Click on each profile button in turn and confirm that all speakers in each profile display 
the expected data. Once you have checked the configuration over, click the Save All to 
DEQX button. 

DEQX-Cal will package up the filters and other data for all four profiles and upload them 
to the DEQX. A progress dialog keeps you informed: 

Now save the project. 

Don't forget to use “Save All to DEQX” every time you edit or update your 
configuration. Remember also that all four profiles will be uploaded to the DEQX. 
 

 A NOTE ON LIMIT FILTERS AND DELAYS FOR ADVANCED USERS  

By default, the Max Delay parameter used to generate a correction filter in single amp 
mode is set to 3 ms, out of a possible maximum 24 ms. 

When limit filters are set, the delay of the correction filter is subtracted from the 
maximum of 24 ms. The examples on page 77 therefore show a maximum delay 
available of 21 ms (24 – 3). If 10 ms delay were used for the correction filter, then the 
Limit Filters tab would show 14 ms maximum. 

Limit filters can be linear phase, as well as the Linkwitz-Riley examples given in this 
chapter. If using stereo subwoofers located next to the left and right loudspeaker, for 
example, the frequency of the crossover to the subwoofer can often be set significantly 
higher than the examples given earlier in this chapter. Linear phase filters may then be 
feasible, but will be limited in frequency/slope by the available delay. A higher delay in 
the correction filter may reduce the delay available in the limit filters.  

DEQX-Cal manages the delays of all filters specified in a profile and provides warnings if 
the maximum allowable delay is exceeded. The advanced user, however, should be 
aware of the interaction between the delays and make the appropriate trade-offs. 
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9.9 TO RE-OPEN A CONFIGURATION 

Each configuration is stored in the project file. Any edits to a configuration are saved 
when the project is saved. 

There are two ways to open an existing configuration for viewing: 

1. By using the configuration wizard. Click the Configure button to start the wizard. 
On Screen 2, select the option “Load an existing DEQX configuration.” Select the 
configuration that you wish to load from the pane underneath, and click Finish. 

 

2. From the project explorer. Unfold the PDC CONFIGURATIONS folder, right-click on 
the configuration that you wish to open, and select “Open” from the popup menu. 
(If this entry is greyed out, the configuration is already open and you can bring it to 
the front from the Window menu.) 

 
The popup menu can also be used to rename and delete a configuration (see 
page 148).
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10 ROOM MEASUREMENT  

Once the speakers and subwoofers have been calibrated, their 
anechoic response has been corrected in both frequency and 
time. When placed in a room, however, reflections and 
resonances in the room act to degrade the frequency response. 

To correct for the effects of the room, the DEQX uses parametric EQ, described in 
Chapter 12. As a starting point for room EQ, a room measurement is necessary – that is, 
the response of the speakers (and subwoofers) when measured from the listening 
position. Room measurements are also used to integrate the subwoofers (if used) with 
the main speakers. 

When taking room measurements, the speakers and subwoofers are positioned in their 
regular locations. If you are still experimenting with the best locations for the speakers 
or subwoofers in the room, be aware that you will need to redo your room 
measurements and EQ each time you move the speakers or subwoofers. The room 
measurement can in fact be used to help you determine the optimum locations for 
speakers and subwoofers. 

It is important to be aware that room measurements show the response not only of the 
speakers and subwoofer(s) but also the effect of a long series of resonances and 
reflections in the room. They are very different in nature to the anechoic and nearfield 
measurements taken in earlier chapters. There is no such thing as a “clean” room 
measurement. 
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10.1 ROOM MEASUREMENT SETUP 

In Chapters 6 and 8, the speaker, subwoofer and microphone were positioned in order 
to minimize the effect of the room on the measured response. Now that the speakers 
and subwoofers have an accurate, calibrated response, it is time to measure them 
together with the full effect of the room. 

Position the speakers and subwoofers (if used) in their normal locations. For the first 
measurement, place the microphone at the center of the listening area, at ear height. 
Position the microphone horizontally and point it between the speakers. 

Set the controls on the subwoofer as when initially measured: disable its low pass filter 
(crossover) if possible, or if not, set it to its highest frequency; turn off any equalization 
in the sub; and set any phase or invert controls to their neutral positions. 

Your initial room measurement may reveal room-related problems that are best 
corrected by moving the speakers or subwoofers. We suggest that you initially take a 
single room measurement and examine it (pages 89 and 90) to establish whether better 
results would be obtained with the speakers or subwoofers in a different location. 

Figure 3. Room measurement setup 
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10.2 START THE ROOM MEASUREMENT WIZARD 

Start the room measurement wizard by clicking on the Measure 
Room button in the Wizard toolbar or by selecting it from the 
Tools menu. 

The wizard will take you through a series of screens. To proceed through them, select 
the necessary options on each screen and click the Next button. If you realize you've 
made a mistake or need to check what you've done, click the Back button to go back 
through the screens. 

Screen 1. If you have more than one project open, this screen allows you to select the 
project in which the measurement will be stored. Otherwise, this is an informational 
screen only. 

Screen 2. Create a new room measurement, or select an existing measurement to 
open. (The following steps assume that you have selected “Create a new room 
measurement.”) 

10.3 SET ROOM MEASUREMENT PARAMETERS 

Screen 3. This screen sets a number of parameters that control the measurement.  

 

Room Name 

Enter the name of the room being measured. If you have previously done room 
measurements, you can select from these rooms using the drop-down menu.  
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96k Measurement 

If this box is checked, the DEQX runs the measurement at a 96 kHz sample rate. 
DEQX recommends leaving this box checked for all measurements. 

Include parametric filters 

If this box is checked, the DEQX includes the effect of all parametric EQ filters 
(room EQ and the three-band Preference EQ set by the DEQX Remote). To 
measure the effects of the room only (without parametric EQ), leave it unchecked. 

If you check this option and intend to measure the effects of room EQ but without 
including Preference EQ, reset Preference EQ with the DEQX Remote (page 37). 

Source 

This option selects from one of several sweep lengths. At 
right are the choices for a 96 kHz measurement, ranging 
from 0.3 to 1.4 seconds. Longer sweeps give higher 
resolution measurements. 

Average over 

The DEQX can make multiple measurement sweeps in 
order to improve the signal-to-noise ratio of the 
measurement. DEQX generally recommends a minimum 
of 9 sweeps to guard against noise corrupting the 
measurement. For quick confirmation and verification 
measurements, however, 3 sweeps may be adequate. 

Profile selection 

Selects which profile will be active while the measurement is being 
taken. (If you have set up your initial correction profile as suggested 
on page 76, select Profile 𝟣.) 

Skip level setting page 

If this box is checked, DEQX-Cal skips Screen 6, in which you set the playback 
level of the test signal. Check this box only if you previously taken a room 
measurement and set the master volume to a suitable level, as a timesaving 
feature and to ensure consistent levels. 

Measure drivers concurrently 

With the bi-amp and tri-amp speaker configuration modes, this checkbox makes 
both (bi-amp) or all three (tri-amp) drivers be measured together, and is the usual 
choice. Even with the single amp speaker configuration modes, leave this box 
checked – this means that the level setting screen uses the main speaker to set 
the measurement level. 
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10.4 SET LOCATION AND SPEAKERS TO BE MEASURED 

Screen 4. Select the speakers and subwoofers to be measured. Shown below is the 
screen for the “single amp with optional mono subwoofer” speaker configuration mode. 
(If you have not enabled the subwoofer, it will display as “Sub (Disabled)” and be 
deselected by default.) 

Usually, you will run the room measurement on all enabled outputs. You can select and 
deselect specific channels with the checkboxes if you wish. 

Screen 5. Provide a name for the measurement position. To start with, you could name 
it “Center location.” 

When you take further room measurements, existing measurements done in the same 
room will appear in the list above the entry box. For example: 

Click Run to continue. 
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10.5 RUN THE MEASUREMENT 

Screen 6. DEQX-Cal will upload the test signal to the DEQX, as shown by the 
“Initializing DEQX” indicator. 

When the indicator changes to “Playing test signal,” adjust the measurement signal 
level as described on page 50. For a room measurement, however, the input level 
should typically be peaking in the range of 75–85 dB. 

Click Run to proceed. 

Screen 7. DEQX-Cal runs through a series of steps to measure the selected speakers 
and subwoofers: 

The measurement proceeds in a similar manner as for a speaker measurement, but for 
each selected speaker and subwoofer in turn. 

As the measurement of each speaker or subwoofer completes, the wizard displays its 
confidence level. With room measurements, the confidence level is much less critical 
than it is for speaker measurements, as room measurements are not used to directly 
generate correction filters. As long as DEQX-Cal completes each measurement item 
with a green tick, you can consider the measurement to be acceptable. 
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Screen 8. When the measurement process is completed, thumbnails of the room 
measurements are displayed. Most of the time, you will simply click on Accept. If you 
think there is an error in the measurement (for example, from unexpected external 
noise), click Retry to run the measurement again.  

 

Screen 9. This is the exit screen. 

 

x To proceed with subwoofer integration or room EQ now, leave the box “View room 
measurement in IO Manager / parametric EQ” checked and click Finish. (This is a 
convenience feature to take you directly to the Equalizer tab of the DEQX Control 
Panel.) 

x To assess the initial room measurement as described on pages 89 and 90, uncheck 
“View room measurement in IO Manager / parametric EQ” and click Finish. Then 
open the measurement that you have just taken in a new data viewer (see next 
page). 

x If you wish to do additional room measurements at this point, click More to be taken 
directly back to Screen 5. (The level setting screen will be bypassed when taking 
additional measurements, in order to ensure matching measurement levels. See 
pages 103 and 104 for more information on using multiple room measurements.) 
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10.6 TO OPEN EXISTING ROOM MEASUREMENTS 

There are three ways to open existing room measurements: 

1. Using the room measurement wizard. Click the Measure Room button and on 
Screen 2, select the option “Load an existing room measurement.” In the pane 
underneath, select the measurement or measurements to open. 

On Screen 3, select the data viewer in which to open the selected measurements. 
By default, this is the Equalizer tab of the Control Panel: 

2. From the project explorer. Unfold the ROOM MEASUREMENTS folder, navigate to 
the measurement position that you wish to open, right-click and select “View” from 
the popup menu: 

You can also unfold a measurement position and open single room measurements 
from within it. (See page 103 for an example.) 

3. With drag and drop. Unfold the project as above, then drag a measurement from 
the project explorer and drop it onto an open data viewer or onto the Equalizer tab 
of the IO Manager. (You may need to bring the desired data viewer to the front by 
selecting it from the Window menu before you do this.) 
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10.7 ASSESS THE INITIAL MEASUREMENT 

The measurement taken in the center of the listening area can be examined to confirm 
suitable speaker and subwoofer locations. It can also be used to confirm that the 
microphone has in fact been placed in the center of the listening area. 

The procedures in this section are optional, but you may find that you get a better end 
result by using them. To proceed, start by opening the room measurement taken at the 
center of the listening area in a new data viewer. 

You will need to zoom in on the plots to view them more clearly. To do so, 
click the zoom icon in the toolbar and then either click on the graph or drag 
out a rectangle around the area of interest. For more detailed information 
on how to work with the measurement plots, see Chapter 16.  

 

10.7.1 Speaker location 

When a DEQX is used in your system, the optimal speaker (and subwoofer) placement 
may be different to what you have previously found. Without the DEQX, you may have 
(even unknowingly) chosen a speaker location and listening position that tends to result 
in low output at low frequencies, in order to avoid “boominess.” 

With a DEQX’ capability to linearize the speaker/subwoofer response and address room 
modes, the optimum speaker and listening positions are often those that tend to excite 
room modes more. The peaks can be addressed by the DEQX, with a better end result 
and less risk of overdriving amplifiers. 

The example below shows the measurements of two speaker and listening location 
combinations in the same domestic living room. In both cases, the microphone was 
approximately 2.4 m (8 feet) from the speaker. The response shown in blue is likely to 
lead to a better end result than the response shown in dotted red, which has significant 
“suck-out” in the 50 – 75 Hz and 160 – 180 Hz ranges. 
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10.7.2 Subwoofer location 

If a subwoofer or subwoofers are used, the same principle applies. If possible, choose 
subwoofer locations that enhance bass output. Often, one or both corners behind the 
speakers will work well. 

The example below shows the response of a subwoofer at two different locations in the 
room. While the dotted red response initially looks flattest, it has a suckout in the 
frequency range from 75 to 100 Hz that cannot be effectively addressed with EQ. The 
solid blue curve has a peak at 48 Hz and may – without room EQ – sound a little boomy. 
However, once the low frequency response curve has been corrected with room EQ, the 
end result is likely to be better. 

10.7.3 Microphone location 

To check that the microphone is the same distance 
from both speakers, click the Time button in the 
Chart toolbar. Zoom in on the plots to clearly display 
the impulse responses of the left and right speakers. It is not uncommon to see a 
difference of a tenth or two of a millisecond between the two impulse response peaks, 
due to the microphone not being positioned exactly equidistant from the two speakers. 
If the difference between the two speakers is more than this, check your microphone 
position and repeat the measurement. 
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11 SUBWOOFER INTEGRATION 

To integrate subwoofers means to ensure that they are correctly time-aligned with the 
main speakers and matched in level. While this manual presents subwoofer integration 
before room EQ, it is also possible to do it afterward once you are familiar with the 
operations involved. In either case, the final subwoofer level is a result of listening to a 
variety of program material. 

If you are not using subwoofers, skip this chapter. 

11.1 VIEW THE ROOM MEASUREMENT 

Open the most recent room measurement taken at the center of the listening area. The 
screenshot below shows a typical example with stereo subwoofers. (If you left “View 
room measurement in IO Manager / parametric EQ” checked on the exit screen of the 
room measurement wizard, this window will already be open.) 
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11.2 LEVEL MATCHING 

To determine level adjustments, the Scale parameter of each plot (lower right of the 
window) will be adjusted to visually equalize the level of all plots. 

As a starting point, you can use the Normalize to 0 dB button. Deselect the subwoofers 
(so only the speaker plots are displayed) and click on Normalize to 0 dB. Then select 
the subwoofers, deselect the speakers, and click on Normalize to 0 dB again. 

11.2.1 Level matching stereo subwoofers 

Display the plots for the left speaker and left subwoofer. Adjust the Scale value of the 
left subwoofer so that its baseline is at or slightly above the average level of the speaker 
in the region from 100 to 1000 Hz. This diagram illustrates what we mean by “baseline” 
– it allows for subsequent EQ that “pulls the peaks down”: 

For example, the plot below shows the left speaker in green, the left subwoofer before 
adjustment in dashed red, and the left subwoofer after adjustment in solid blue: 

Repeat for the right speaker and right subwoofer. 

11.2.2 Level matching a mono subwoofer 

Because the mono subwoofer carries signal from both input channels, the way that 
initial level matching is performed is slightly different to that for stereo subwoofers. 

Display the plots for the left speaker and the subwoofer together. Adjust the Scale 
value for the subwoofer so that the baseline level of the subwoofer plot is about 5 dB 
higher than the average level of the speaker in the region from 100 to 1000 Hz. (5 dB is 
one division on the vertical scale.) 
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For example, the plot below shows the left speaker in green, the subwoofer before 
adjustment in dashed red, and the subwoofer after adjustment in solid blue: 

11.2.3 Calculate gain adjustments 

The gain adjustments are calculated from the Scale values in the plot selector. Here is 
an example of a set of scale values after adjusting as described above: 

To calculate the gain adjustments, assign the plot with the highest Scale the value 𝟢, 
and then calculate the gain adjustment for the others using this formula: 

gain_adjustment = − (highest_scale – this_scale) 

This diagram illustrates for the above Scale values: 

In this example, we need to adjust the gains of the subwoofers. If you need to adjust the 
gains of the main speakers instead, adjust the gains of both speakers by the same 
amount. (In some cases, a slightly different adjustment to each speaker can be useful 
but this should only be done with careful auditioning.) 

If a substantial gain adjustment is needed, it may be advisable to adjust the analog 
gains in the system and re-measure. For subwoofers, this can often be done simply by 
adjusting their onboard gain controls. If not, see Appendix D. 
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11.3 TIME ALIGNMENT 

Time delays between the speakers and subwoofers are calculated using their impulse 
responses. The delay that needs to be added to speakers or subwoofers depends not 
only on their physical distance from the listening position but also the delay in the filters 
that have been applied to them. The following method accounts for all of these factors. 

In order to determine time delays, it is necessary to view the impulse response of the 
speakers and subwoofers. The impulse response cannot be viewed in the Equalizer tab, 
so the measurements will need to be opened in a data viewer by using the room 
measurement wizard (page 88) or by using the project explorer, like this:  

11.3.1 Determine speaker delay 

Open one of the speaker measurements and click the Time button in the chart toolbar 
to display its impulse response. 

To zoom in on the impulse response, click on the zoom icon in the toolbar and then drag 
out a rectangle around the impulse response so that it can be viewed clearly: 
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Right-click on the plot and select “Markers” then “Vertical.” Place one of the markers at 
the impulse response peak. In this example, the delay of the speaker is 22.3 ms:  

11.3.2 Determine subwoofer delay 

Open the measurement of each subwoofer as described above, and click the Time 
button to display its impulse response. Use a vertical marker to find the time delay of 
the first peak. In this example, the delay of the subwoofer is 31.8 ms: 

11.3.3 Calculate relative delays 

The delay to be added to the speakers or to each subwoofer is given by this formula: 

delay_adjustment = longest_delay – this_delay 

This diagram illustrates for the above time delay values:  

Note that both speakers should always have the same delay adjustment. 
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11.4 UPDATE THE CONFIGURATION 

Return to the configuration window. Then: 

1. Ensure that you have selected the correct profile.  

2. For each speaker or subwoofer that requires a delay, double-click on its icon to open 
its Filter Properties dialog. On the Time/Level tab, set the calculated delay value for 
that speaker or subwoofer. 

 
Click OK to close the dialog. The speaker (or subwoofer) icon updates to show the 
delay: 

 

3. For each speaker or subwoofer that requires a gain adjustment, double-click on its 
icon to open its Filter Properties dialog. On the Time/Level tab, set the calculated 
gain adjustment for that speaker or subwoofer: 

Click OK to close the dialog. 

4. Click on Save All to DEQX. 

5. Save the project. 

11.5 RE-MEASURE THE ROOM 

Before proceeding with room EQ in the next chapter, redo your room measurement. 
This will give you a measurement with the correct initial levels for room EQ. 
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12 ROOM EQ 

The DEQX uses parametric equalization (EQ) to correct for the effects of the room. 
Room EQ can be applied anywhere in the frequency range, but is typically most 
effective in the modal region (below 200 to 300 Hz, depending on the room). 

Room EQ starts based on room measurements, but these measurements are only a 
guide. Always confirm your EQ settings by listening to a variety of music and making 
further adjustments as needed. You will never get a “perfect” room measurement. 

Room EQ is done in the Equalizer tab of the Control Panel – see the annotated 
screenshot below. This is a customized version of the data viewer that adds two buttons 
for EQ control, Autoset EQ and Invert EQ. There is also a plot for the equalization 
curve, named “Equalizer” and displayed in blue (by default). 

Room EQ is done per-profile, so use the Profile buttons to select the same profile that 
you used when making this room measurement (“Profile Selection” on page 84). In the 
example screenshot below, Profile 1 is selected. 
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12.1 HOW TO USE MANUAL EQ 

To add an EQ control point, right-click on the plot and select 
“Add Point” from the menu, or click the Add Point button in the 
chart toolbar. Then click on the plot display area. 

The example below shows an EQ curve for stereo subwoofers with four control points 
added. (The plot has been zoomed in to show the frequency range from 10 to 200 Hz.) 

In this example, the EQ curve is set to “pull the peaks down.” This can be done because 
the subwoofers’ Scale has been set so that their baseline is at about 𝟢 dB. 

To change the center frequency and gain of a filter band, click and drag the control 
point. To change the width, click and drag either of the two vertical bars. These bars are 
located at the “half way" points of the filter. (For example, if the filter is set for a gain of 
−6 dB, the bars are at the frequencies of −3 dB gain.) As a general rule, narrow filters are 
used at low frequencies and wider filters are used at higher frequencies. All changes are 
“live,” so the effect can be heard while listening to music. 

A tooltip overlay displays the 
parameters of a filter band. Exact 
parameters can be set by double-
clicking on the control point to bring 
up the dialog box shown at right. 

Frequency 

The center frequency of the 
filter band. 
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Gain 

The gain of the filter band in dB. (Positive is boost and negative is cut.) As a 
general rule, gains greater than 6 dB should be used with caution, as doing so 
may require substantial additional amplifier power. 

Q 

The width of the filter band. High values represent a narrow filter, low values a 
broad filter. When Q is set, Bandwidth automatically updates. 

Bandwidth 

This drop-down menu selects the bandwidth of the filter either in Hertz or in 
octaves. When Bandwidth is set, Q automatically updates. 

You can add up to ten points to the EQ curve. If you add more than seven, you will 
receive a warning that Preference EQ (pages 34 to 37) will no longer work. 
 

 TIPS FOR MANUAL ROOM EQ  

Room measurements typically exhibit a downward “tilt” from low bass to high treble of 
6 up to 15 dB. This is caused by a number of factors including reduced dispersion and 
greater absorption in the room at high frequencies. Do not attempt to EQ your room 
measurement completely flat – that will most likely sound overly bright.  

Here is a simple and effective way to create a suitable manual EQ curve. First, create 
control points that “follow the curve,” as in this example: 

Then click the Invert EQ button to obtain the “right way up” EQ curve as shown on the 
previous page. (If you use this method, be sure to always set the EQ curve to the correct 
orientation before re-measuring or listening to the effect of the EQ.) 

If you have difficulty creating a suitable EQ curve, adjust the Scale parameters in the 
right-most column of the plot selector – this may result in a simpler curve. 

Always audition the effect of any EQ. Using multiple profiles to set up different EQ 
curves can be helpful to find the optimum settings. 
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12.2 HOW TO USE AUTOSET EQ 

The Autoset EQ feature provides a calculated starting point for further manual EQ 
adjustments. It will aim for “minimal disturbance” by creating narrow filters and 
choosing conservative gains. If multiple plots are selected, it will only make corrections 
that have the same effect on all measurements. (For example, it will not reduce a peak 
if that peak is not present in all of the selected plots.) 

To use it, first select the plots that you want the EQ to be calculated against. Then click 
the Autoset EQ button. The options for Autoset EQ are as shown at right below. (The 
greyed-out option “Only EQ common response” is always on.) 

Min Freq, Max Freq 

Set the minimum and maximum frequencies 
that Autoset EQ will assign to filter bands. 

Number of bands 

Sets the number of filter bands that you want 
Autoset EQ to use. This can be up to ten, but 
if greater than seven, Preference EQ (as 
described on pages 34 to 37) will be disabled. 

Maximum Boost, Maximum Cut 

Set the maximum boost and cut that Autoset 
EQ will assign to any filter. As a general rule, 
avoid using more than 6 dB of boost. 

EQ style 

“Parametric” sets each filter band at the location where maximum cut or boost is 
needed whereas “Graphic” equally spaces the filter bands. “Parametric” is usually 
the best choice. 

This example illustrates the effect of Autoset EQ on stereo subwoofers. This curve can 
now be fine-tuned using manual EQ: 
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12.3 FINE-TUNE YOUR RESULTS 

The EQ control points on the Equalizer tab are “live” – that is, the effect on the audio 
will be heard immediately as they are changed. Once you have set up an initial EQ 
curve, play music (or movies) through the DEQX and adjust the control points to obtain 
the best audible result. Small changes can make quite a difference, so listen to a variety 
of different tracks. 

If you are using subwoofers, you can also use the Gain adjustment buttons in the IO 
Manager (pages 132 and 133) to increase or decrease the level on channels L1 and R1. 
For example, after addressing room modes you may find that bass sounds “lighter” than 
expected, so increasing subwoofer level by 2–3 dB can correct this impression. (Once 
you have found the best setting in the IO Manager, you will write that back into the 
configuration – see step 5 on the next page.) 

Remember also that the DEQX Preference EQ has not yet been harnessed. Even if you 
like a lot of bass, it is best to find a neutral bass level here. Later on, set up your 
Preference EQ as described on pages 34 to 37. 

You can also do additional room measurements to verify the 
effect of your EQ settings. The procedure is the same as 
described in Chapter 10, except that you must enable the 
“Include parametric filters” option on Screen 3. 

Check that your EQ curve is not inverted before running the measurement. Also make 
sure that you have reset the Preference EQ with the DEQX Remote (page 37). 

The new measurement can be compared to the original. While (as mentioned on 
page 81) room measurements will always look “rough,” you can see in the example 
below how room EQ has mitigated the worst effects of the room – “before” is in red and 
“after” in green. (Remember also that this is just one of two speakers.) 
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12.4 UPDATE THE CONFIGURATION 

With room EQ and levels adjusted to your satisfaction, these new settings need to be 
copied to the configuration and saved. 

1. Open the configuration if it is not already open (page 80). 

2. In the configuration window, select the same profile that you 
have been applying EQ to. 

3. Click the Read EQ from DEQX button: 

4. The EQ points for all four profiles will be downloaded from the DEQX. On the 
Configuration tab, the parameters of the EQ filter bands will be shown numerically 
(below left). On the Equalizer tab, the EQ filters will be shown graphically (below 
right). 

 

5. If you have changed subwoofer channel 
levels in the IO Manager, adjust gain in the 
Filter Properties dialog box of each 
subwoofer by the same amount. After 
doing this, return to the IO Manager and 
reset the channel gains back to zero. 

6. Click Save All to DEQX to upload the updated configuration to the DEQX. 

7. Save the project.  
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 COPYING ROOM EQ FILTERS  

Parametric room EQ filters can be copied between profiles using cut-and-paste 
operations. For example, to copy room EQ settings from Profile 𝟣 to Profile 𝟤: 

1. Click on the Profile 𝟣 selector button.  

2. Right-click in the Profile Settings area and select “Copy” from the popup menu. 

3. Click on the Profile 𝟤 selector button.  

4. Right-click in the Profile Settings area and select “Paste” from the popup menu. 

 

 VIEWING MULTIPLE ROOM MEASUREMENTS 

Multiple measurements around the listening area can be used to perform more 
comprehensive room analysis and EQ. To take a series of measurements with different 
microphone positions, click on More on Screen 9 of the room measurement wizard 
(page 87). You will be taken back to Screen 5, where you can enter the name of the new 
position and proceed with another measurement. 

When viewing multiple measurements for room EQ, it is often desired to view a single 
speaker or subwoofer, but at multiple positions. (For example, the subwoofer at four 
different measurement positions.) One way to do this is to use the room measurement 
wizard, select “Load an existing room measurement,” and then use the checkboxes to 
select the required individual measurements. 

A second approach is to use drag and drop from the project explorer – locate each 
measurement in turn and drag and drop it onto the Equalizer tab of the IO Manager. 

This example shows the measurements of a subwoofer at four different locations: 
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 USING MULTIPLE ROOM MEASUREMENTS  

While the central position is generally a good indicator of the overall response around 
the listening area, multiple measurements can be used to refine your EQ, especially if 
the listening area is large. 

Method 1: Take multiple measurements first 

Take several measurements around the listening area and load them into the Equalizer 
tab of the Control Panel. Click Normalize to 𝟢 dB, and then on Autoset EQ to get a 
starting point. Autoset EQ takes a conservative approach when asked to EQ multiple 
plots, so manual adjustment may then be needed. This composite illustrates:  

Method 2: Take multiple measurements later 

Use the central position of the listening area to do your room EQ. Then take several 
measurements around the listening area, being sure to enable “Include parametric 
filters” on Screen 3 of the room measurement wizard. Load the measurements into a 
data viewer and use the Sum button to see how applicable your EQ is across the 
listening area. For example, the summed measurement below (in purple) suggests that 
a little more cut at 80 Hz may be beneficial. (The green plot is the same speaker 
measured at the central position, for comparison.) 
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13 ACTIVE MULTI-WAY SPEAKERS 

When used in the bi-amp and tri-amp speaker configuration modes, the DEQX becomes 
the heart of an active speaker, with each driver being driven by a dedicated amplifier 
channel. The bi-amp and tri-amp speaker configuration modes are supported by the 
HDP-4, HDP-5, and HDP-Express II. 

The bi-amp and tri-amp configurations are considered an advanced mode of operation, 
as using them will require knowledge of the intricacies of speaker design as well as 
improved measurement technique. The explanation assumes that Chapters 5 to 9, 
which focus on the single-amp speaker configuration modes, are already fully 
understood. 

Bi-amp and tri-amp modes can potentially damage drivers if settings are incorrect. The 
symbol at left will appear wherever particular note must be paid to settings or options. 

13.1 ACTIVE CONFIGURATIONS WITH DEQX 

By way of introduction to active speakers, Figure 4 illustrates a system using a pair of 
passive two-way speakers and a DEQX running in single-amp speaker configuration 
mode. The internals of the right speaker are shown for illustrative purposes. 

Figure 4. Passive two-way speaker 
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Each speaker in Figure 4 has an internal crossover network consisting of passive 
components – inductors (coils), capacitors, and resistors. This passive network divides 
the frequency range into high frequencies for the tweeter and low frequencies for the 
woofer. The transition between the two drivers is gradual, with a slope ranging from 
very shallow to moderate. The passive network typically also does some response 
shaping to compensate for the natural response of the drivers and the acoustic effect of 
the speaker cabinet. 

By removing the passive crossover network and instead using a DEQX to divide the 
frequency range “in front of” the amplifiers, an active speaker is realized, as illustrated 
in Figure 5 on the next page. Each amplifier is thus required to deliver only a portion of 
the full frequency range. The passive crossover is no longer present4, removing any 
possibility of non-linearities in the passive components and giving the amplifiers direct 
control over each individual driver. The DEQX adjusts the response of each driver in 
minute detail, reducing group delay and amplitude errors dramatically and providing 
accurate acoustic transitions between the drivers with steep linear phase filter slopes. 

13.1.1 Active speaker design considerations 

There are many design considerations when implementing an active speaker: raw driver 
response (both on-axis and off-axis), driver sensitivity, baffle size and shape, power 
handling versus frequency vs crossover slope, and so on. With a DEQX at hand, the 
designer may make different choices than when designing a passive speaker. 

The bi-amp and tri-amp modes should therefore be considered advanced modes of 
operation. The following paragraphs discuss specific considerations when using a DEQX 
to implement an active speaker: 

1. As indicated in Figure 5 and Figure 6, a protection capacitor (a high voltage film 
capacitor) in series with the tweeter is generally recommended. This will help 
protect it from DC offsets and turn-on and turn-off transients. If there is any 
question that the amplifier and upstream equipment is not perfectly behaved or 
that the tweeter is fragile, the capacitor is strongly recommended. 

Unlike other systems, the DEQX will compensate for the roll off and phase shift 
introduced by the capacitor. The capacitor therefore does not have to be large (a 
common rule of thumb is to size it so that its roll off starts two octaves below the 
crossover frequency), but sized to roll off at the anticipated crossover frequency. 
Since it is relatively small in size, a very high quality capacitor can be used. 

2. The analog gains post-DEQX should be reasonably well matched. If there are 
significant discrepancies in amplifier gain and driver sensitivity (greater than 5 dB), 
it is recommended that you adjust output analog gain as described in Appendix D. 

                                                                    
4 With the exception of a protection capacitor on the tweeter. See the section “Active speaker 
design considerations.” 
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3. Measurement technique is usually more demanding for the bi-amp and tri-amp 
configurations. In cases such as when measuring a small two-way speaker, a 
sufficiently accurate correction and crossover can be obtained with indoor 
measurement. Otherwise, unless there is access to facilities such as an anechoic 
chamber, it may be necessary to: 

a. Take measurements outside (or in a large structure such as a gymnasium), and 

b. Use a raised platform to extend the time to the first reflection. (In this case, 
ensure that the platform does not extend past the front of the speaker, as that 
will create its own reflection.) 

The following sections describe the main active speaker configurations as well as hybrid 
active-passive configurations. Take careful note of the output connections (L1 etc.) on 
each diagram. (For configurations using more than one DEQX, see Chapter 14.) 

13.1.2 Active two-way speaker 

Figure 5 shows the physical connections for an active two-way speaker. If stereo 
subwoofers are used (as shown in the diagram), set the speaker configuration mode to 
“bi-amp with optional stereo subwoofers.” 

If a single subwoofer is used, connect it to L1 only and set the speaker configuration 
mode to “bi-amp with optional mono subwoofer.” 

If no subwoofer is used, the speaker configuration mode can be set to either of the two 
bi-amp modes and the subwoofer channels left disabled. 

Figure 5. Active two-way speaker  
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13.1.3 Active three-way speaker 

Figure 6 shows the physical connections for an active three-way speaker. The DEQX can 
use two different speaker configuration modes: 

Tri-amp 

The tri-amp speaker configuration mode is the most demanding of accurate 
measurements. The reflection-free time window must be long enough that 
correction can be done to well below the woofer-mid crossover frequency. In 
addition, the acoustic half-space to full-space transition due to the cabinet will 
need to be taken into account. 

Bi-amp with optional stereo subwoofers 

In this case, the “subwoofers” are the main woofers of the speaker and the limit 
filters are simply set higher than is typical for subwoofers. Measure and calibrate 
the tweeter and midrange drivers as for a two-way active speaker, and measure 
and calibrate the woofers using a nearfield measurement as for subwoofers 
(Chapter 8). Alternatively, you can use an in-room calibration for the woofers, as 
described on page 121. Set up the woofer-midrange crossover with limit filters, as 
explained on pages 118 and 119. 

To add subwoofers to this type of speaker, see page 123.  

Figure 6. Active three-way speaker  
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13.1.4 Hybrid active-passive speakers 

With speakers that bring out separate internal crossover networks to the binding posts, 
the DEQX can be used to implement a hybrid active-passive speaker. The existing 
passive crossover can be left untouched to split the frequency range; alternatively, the 
DEQX can be used to override the passive crossover (with some limitations). 

In the case of a two-way speaker, the physical connections are as shown in Figure 5, but 
the tweeter and woofer each retain their own internal passive filter network. Calibration 
proceeds in much the same manner as for an active two-way, but the crossover 
frequency will need to be set at or somewhere near the crossover frequency defined by 
the passive crossover. The DEQX will compensate for the frequency and phase response 
of the passive crossover and still realize an ideal linear-phase crossover. 

In the case of a three-way speaker with three pairs of binding posts, connections and 
calibration are similar to an active three-way speaker (page 108). In other cases, the 
speaker may have two pairs of binding posts, with the mid-tweeter network brought 
out to one pair and the woofer network to the second pair. If so, there are two options: 

x If the woofer-mid crossover frequency is high enough (at least 300 Hz), it may be 
possible to use a bi-amp speaker configuration mode as described above. 

x Otherwise, use the “single amp with optional stereo subs” speaker configuration 
mode, with connections as shown in Figure 7 below. Some care will be needed if using 
limit filters between the woofer and mid-tweeter networks. 

Figure 7. Hybrid active-passive three-way speaker  
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13.2 MEASURING MULTIPLE DRIVERS 

Each driver of an active speaker is measured in turn, starting with the woofer. 
Measurement technique for the bi-amp and tri-amp configuration modes generally 
needs to be better than for single amp mode. A longer reflection-free time window will 
be required not only for lower crossover points (in the case of tri-amp), but also to take 
account of the transition of acoustic radiation from half-space to full-space as 
wavelengths become greater than the baffle width (also known as diffraction loss or 
“baffle step”). 

The overall procedure is the same as for the single-amp configuration described in 
Chapter 6, with specific differences noted here. 

Screen 3. Set the Configuration parameter to “Bi amp” or “Tri amp.” 

Usually, the option “Display prompt in between drivers” is checked, so that the 
microphone can be moved between the measurements of each driver. This may not be 
necessary in bi-amp mode, but usually will be in tri-amp mode. 

Screen 3a. After clicking Next, an additional screen appears. This screen can be used to 
set a lower frequency limit on the measurement sweeps for the tweeter and midrange 
drivers. As a rule of thumb, the lower frequency limit should be set one to two octaves 
below the intended crossover frequency. 

 

The tweeter is especially prone to damage if this option is turned off. Be sure that you 
understand the potential consequences before turning off this option.
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Screen 5. Select the speaker to be measured. If this is the first measurement, this is a 
good time to confirm that you have made your output connections to the rear panel 
correctly, as indicated in the “Connections” list on the left: 

Screen 6. Any of the (two or three) drivers can be selected for test signal playback (left-
hand side of the example screenshot below). The woofer is the default, but a different 
driver can be selected by clicking on its radio button. This will result in a short pause 
while a new test signal is uploaded to the DEQX. The test signal will then resume from 
the selected driver. 

If you have not previously checked driver levels, first select each driver in turn while 
playing the test signal at a low volume. Only then increase the volume. 

Screen 7: Measurement sweeps execute for each driver in turn, starting with the 
woofer: 
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Screen 7a: If the option “Display prompt between drivers” was selected, the following 
prompt appears after the woofer and midrange measurements. Move the microphone 
to the correct location for the next driver, then click OK. 

Screen 8: After the tweeter measurement completes, you can accept the measurement 
or retry. The response thumbnail on this screen will show all (two or three) driver 
responses. 

13.3 IMPORTING MEASUREMENTS 

Measurements can be imported from a third-party measurement program. This feature 
is intended for use by speaker designers who may need to import measurements taken 
by a third party or in a different location. The primary intended format is an MLSSA 
“.TIM” format (binary impulse response) file. 

In addition to the MLSSA “.TIM” format, text files in FRD format (textual frequency 
response) can also be imported. This is, however, intended only for comparative 
viewing of measurements, not for speaker calibration. Poor calibration results may be 
obtained if imported text files are used for calibration. 

To begin, select “Import Measurement” from the File menu. The measurement import 
wizard is similar to the speaker measurement wizard, except that existing 
measurement files are selected. After you select the speaker configuration mode, the 
wizard will ask you to select the measurement files (one per driver). 

On the next screen, set the resampling frequency to be the same frequency at which 
the measurement was taken. The option is also available to have minimum phase 
response inferred from each driver’s amplitude response. 

After entering a set of informational parameters (similar to screen 3 on page 47), the 
measurement will be imported. Open the imported measurement in a new data viewer 
to check for successful import prior to starting a calibration. 
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13.4 CALIBRATING AN ACTIVE SPEAKER 

Calibration proceeds in a similar manner to Chapter 7, with specific differences noted 
here. 

Screen 3. Choose “Bi amp” or “Tri amp.” 

When the Calibration window opens, it will be seen that there is an additional tab, 
Crossovers. As before, you will usually proceed through these tabs in sequence, but can 
also jump back and forth by clicking on individual tabs. 

 

13.4.1 Anechoic tab 

Set the time window as described on page 56. This time, there will be two or three 
impulse responses visible, one for each driver. 
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13.4.2 Smoothed Measurements tab 

Two or three plots will be visible, being the anechoic frequency response of each driver. 
Set the smoothing as described on page 57. 

 

13.4.3 Crossovers tab 

There are quite a number of plots on this tab, so you may find it easier to work with if 
you selectively turn them off and on (in the plot selector underneath). 

The example below shows the woofer and tweeter responses for a bi-amp 
configuration. The crossover filters are shown in light blue and red, and the crossover 
setting control in heavy blue: 
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To change the crossover frequency, drag the central control point (below left). To 
change the crossover slope, drag one of the two lower control points to the left or right. 
Alternatively, double-click on the crossover control to bring up a dialog that allows you 
to enter the frequency and slope directly (below right). 

Hovering the mouse over a control point will display the crossover frequency and slope. 
The frequency and slope are also displayed above the plot area, together with the delay 
introduced by that choice of frequency and slope, and the maximum allowed delay. 

(If you choose a combination of frequency and slope that exceeds the maximum 
allowed delay, a dialog box will warn you.) 

The choice of crossover frequency and slope is a trade-off between driver on-axis and 
off-axis response, distortion, excursion limits, and other potential driver issues such as 
resonance or ringing. DEQX recommends a slope between 48 and 96 dB/octave for 
most speakers. Higher slopes can be auditioned by creating additional correction sets. 
Slopes higher than 96 dB/octave (up to 300 dB/octave) may be important in cases such 
as when drivers have pronounced resonance just outside the pass band, or in order to 
sharply limit signal below the crossover frequency to tweeters and midrange units being 
driven at high power (such as in sound reinforcement applications). 

In the case of hybrid active-passive speakers, set the crossover to the same frequency as 
the passive crossover, or near to it. This frequency will be visible in the plots as the 
intersection of the measured responses. 

Two additional controls are visible on this tab: 

 

Crossover type 

For an active speaker, this setting must always be set to “Linear-phase.” 

For a hybrid active-passive speaker, this can be set to “No Crossovers,” in which 
case both amplifiers will receive the same frequency range and the passive 
crossover in the speaker will work to split the frequency range. 
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Time align individual drivers 

This option causes the DEQX to adjust the filters so that the sound wave from the 
two drivers arrives at the listener at the same time. It should always be turned on. 

Never turn off the crossover for a fully active speaker. Distortion and possible damage 
to one or more drivers is the likely result if the speaker is misconfigured. 

13.4.4 Limits tab 

This tab is used to set the correction frequency limits as described on pages 58 and 59. 
By default, there are two or three (for bi-amp and tri-amp respectively) sets of 
correction limits for cut and boost. (More can be added if needed – see page 59.) 

 

When done, click on Finish and follow the rest of the calibration procedure (pages 60 
and 61). Turn step response correction on (but if the calibration algorithm fails to 
complete, turn it off and try again). 

A new tab will be created showing the correction filter set. Additional correction sets 
can then be created with different parameters (such as crossover frequency, slope, and 
percent smoothing). Each new correction set creates a new tab, as shown at the lower 
right of this example: 
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13.5 CONFIGURING AN ACTIVE SPEAKER 

Configuration proceeds in a similar manner to Chapter 9, with specific differences noted 
here. In the configuration wizard, select the appropriate bi-amp or tri-amp 
configuration: 

13.5.1 Correction filters for speakers 

In the configuration window, open the Filter Properties dialog box for the left speaker. 
On the Main Filter tab, select “Use a correction filter for this loudspeaker”: 

Never select “Bypass correction or crossover for this loudspeaker, but still use limit 
filters” for a fully active speaker. This will send the full frequency range to all (two or 
three) drivers, potentially resulting in damage to tweeters and midrange drivers. 

Select the correction filter from the pane that opens underneath (in this example, the 
individual correction filters have been renamed as described on page 63): 

You can also select a correction filter by navigating to it in the project explorer and then 
dragging and dropping it onto the speaker icon. 
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13.5.2 Correction and limit filters for subwoofers (two-way) 

If using subwoofers with a two-way active speaker (Figure 5 on page 107), you will need 
to measure and calibrate the subwoofers as described in Chapter 8, and configure limit 
filters as described on pages 77 and 78. 

After uploading the configuration to the DEQX (“Save All to DEQX”), you can then 
perform room measurement, subwoofer integration, and room correction as described 
in Chapters 10 through 12. 

13.5.3 Correction and limit filters for woofer-mid crossover (three-way) 

With a three-way active speaker using the “bi-amp with optional stereo subwoofers” 
speaker configuration mode (as per page 108), the crossover between the woofer and 
midrange is implemented with limit filters. Since this crossover is usually at a higher 
frequency than a subwoofer crossover, linear phase filters are typically used. 

First, calibrate the woofers using a nearfield measurement as for subwoofers 
(Chapter 8). Alternatively, you can use an in-room calibration for the woofers, as 
described on page 121. Load the correction filter or filters in the Filter Properties dialog 
box of the “Left Sub” and the “Right Sub” (remember that these are actually the 
woofers). 

To set up a linear phase crossover between the woofer and midrange, open the Filter 
Properties dialog of the left speaker. On the Limit Filters tab, enable the high pass filter. 
Enter the crossover frequency in the Frequency field, then drop down the Filter type 
menu and select “Linear Phase”: 

Then drop down the Slope menu and select the desired slope. Typically, a slope 
between 48 and 96 dB/octave works well, but higher slopes can be auditioned if desired. 

After closing the Filter Properties dialog of the left speaker, repeat for the right speaker. 
Then set up matching low pass filters for the two woofers. While the low pass filter on 
the woofer will usually have the same slope and frequency as the high pass filter on the 
midrange, an asymmetric crossover can be useful in some cases to account for the 
acoustic responses of the drivers near the crossover frequency. 
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It is not required to use linear-phase filters for the woofer-mid crossover. At lower 
frequencies, the delay of linear-phase filters increases significantly, so a Linkwitz-Riley 
filter may be preferable, either to avoid video sync issues or because the Max Delay 
limit is reached with a linear phase filter (see below). 

The Filter type drop-down offers three choices: 

Linear Phase 

Linear phase filters have no phase shift across the audio band. Filter slopes can be 
set in 6 dB increments from 48 to 300 dB/octave. 

Linkwitz-Riley 

Linkwitz-Riley crossover filters are conventional (non-linear phase) filters with 
phase shift above and below the roll off frequency and with symmetrical vertical 
lobing. Filter slopes can be set in 12 dB increments from 12 to 120 dB/octave. 

Butterworth 

Butterworth crossover filters are conventional (non-linear phase) filters with 
phase shift above and below the roll off frequency. Filter slopes can be set in 6 dB 
increments from 6 to 120 dB/octave. 

Note that the filter slope is limited by the maximum allowed delay and the type of filter 
chosen. The maximum allowed delay is displayed in the dialog (24.01 ms in the example 
shown below) and is determined by the delays introduced by all currently selected 
filters. The Slope drop-down menu will always reflect the allowable set of filter slopes 
for a given filter type and frequency. 

If you manually enter an unrealizable combination of frequency, slope, and crossover 
type, the fields are displayed in red: 

 The Filter Properties dialog box cannot be closed until the error is corrected: 

The polarity of individual drivers can be inverted if necessary on the Advanced tab 
(page 124). 
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13.5.4 Viewing correction and limit filters 

To view the complete set of correction and limit filters, go to the Filters 
tab and click the Refresh Filters button. In the example below, the lower 
crossover has been set with 96 dB/octave limit filters and the higher 
crossover with 300 dB/octave crossover slopes. 

13.5.5 Upload to DEQX 

After completing initial configuration, click Save All to DEQX. If implementing a 2-way 
active speaker with subwoofers, proceed to perform room measurement, subwoofer 
integration, and room correction as described in Chapters 10 through 12. If 
implementing a 3-way speaker using the “Bi-amp with optional stereo subwoofers” 
configuration mode, you will need to perform an additional configuration step to set 
delays and levels (see below), after which room measurement and correction can be 
performed. 

13.5.6 Woofer-mid time alignment and level adjustment (three-way) 

A three-way speaker using the “bi-amp with optional stereo subwoofers” speaker 
configuration mode (Figure 6 on page 108) requires a separate level and delay 
adjustment step. (In tri-amp mode, the relative level and delay of the woofer is 
automatically set. This does not happen automatically when the woofer is measured 
and calibrated separately.) 

One effective way to make this adjustment is to complete configuration of the DEQX, 
then run a room measurement. To improve the quality of this measurement, locate the 
microphone 1 to 2 meters (3 to 6 feet) from the speaker and an equal distance from the 
woofer and midrange. 

Open this measurement in a data viewer and determine the relative levels and time 
delays of the woofer and midrange, then set these levels and delays in the 
configuration. Apart from microphone location, the procedure is essentially the same as 
described in Chapter 11. 



Chapter 13. Active Multi-way Speakers 

 121 

13.6 WOOFER CALIBRATION WITH AN IN-ROOM MEASUREMENT 

The woofer of a three-way speaker can be calibrated with a speaker measurement 
taken with the microphone at the listening position. This technique can be used if the 
three-way speaker is being implemented with the “bi-amp with optional stereo 
subwoofers” speaker configuration mode (Figure 6 on page 108). It can also be used 
with a three-way hybrid active-passive three-way speaker (Figure 7 on page 109). 

This method is an alternative to the nearfield measurement and calibration technique. 
It is a little more involved but – if done correctly – can also address room modes directly. 
DEQX recommends that the nearfield measurement and calibration method be used 
first. Once good results are obtained, this method can then be trialed and compared by 
switching between profiles. 

Measurement 

Position the microphone at the center of the listening area and take a speaker 
measurement. Move the microphone around the listening area during the 
sweeps. (Use a higher number of sweeps, and move the microphone after every 
three sweeps.) 

Calibration 

Use a long time window and set smoothing at 100%. If the microphone has been 
moved during measurement, a lower amount of smoothing can also be trialed. 
Use the Limits box to limit boost to the range 3–6 dB and turn step correction off. 

Configuration 

Load the correction filters into the configuration and upload the configuration to 
the DEQX. Then perform an integration step using the procedure described in 
Chapter 11 to set the levels and delays of the woofer and the mid-tweeter. 

The example below shows the Filters tab after configuring the three-way speaker. Note 
that the curves for the left and right woofers are different (compare to the example on 
page 120) and account for room response variations between left and right woofers. 
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13.7 CONFIGURING AN ACTIVE SPEAKER WITHOUT CORRECTION 

An active speaker can be configured without using correction filters. This is a basic form 
of crossover that doesn’t take into account the measured anechoic response of the 
drivers. It is useful for quick prototyping, to simulate passive crossovers, or in situations 
where conditions are not conducive to accurate anechoic measurements. Its use 
requires speaker drivers that are acceptably flat in their pass band and above and below 
the crossover frequency (to an extent that depends on the crossover slope). 

To use this mode, select “Use a crossover filter for this loudspeaker only” on the Filter 
Properties dialog: 

The crossover parameters appear underneath: 

The parameters are the same as those described on page 119 for limit filters, but this 
time they control a symmetric crossover (high pass and low pass). 

If an unrealizable combination of frequency, slope, and crossover type is entered, the 
fields are displayed in red and the Filter Properties dialog box cannot be closed until the 
error is corrected: 

The polarity of individual drivers can be inverted if necessary on the Advanced tab 
(page 124). 



Chapter 13. Active Multi-way Speakers 

 123 

13.8 SUBWOOFER INTEGRATION FOR A THREE-WAY SPEAKER 

The three-way speaker configurations described in this chapter use outputs L1 and R1 
for the woofers. These outputs are therefore unavailable for a subwoofer or 
subwoofers. One very effective method of adding subwoofers to a three-way speaker is 
to chain a slave DEQX unit, as described in Chapter 14. Even without that, however, 
subwoofers can still be integrated effectively, provided that the woofer can be driven 
with a full-range signal at power (that is, without a high pass filter) and the subwoofer 
has an inbuilt low pass filter. 

1. Connect L1 and R1 to the line-level inputs of the subwoofer or subwoofers as well 
as to the woofer amplifier inputs. Ideally, connect to both the unbalanced (RCA) 
and balanced (XLR) outputs as shown below (adapters can be used). Or, use Y-
connectors. 

 

a. For a mono subwoofer, connect L1 and R1 to the subwoofer’s left and right 
inputs. (This assumes that the subwoofer has separate left and right line-level 
inputs.) 

b. For stereo subwoofers, connect L1 to the left subwoofer and R1 to the right 
subwoofer.  

2. In the configuration window, ensure that the high pass limit filter on the woofer is 
turned off. 

3. Adjust the low pass (may also be referred to as “high cut” or “crossover”) filter on 
the subwoofer for the best audible result. You may also need to experiment with 
subwoofer location. 

4. Use room measurements and room EQ (Chapters 10 and 12) to adjust subwoofer 
level and equalize the low-frequency response of the system. You may need to 
change subwoofer location or adjust the subwoofer’s low pass filter when doing 
this. 
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13.9 ADVANCED CONFIGURATION OPTIONS 

The Advanced tab of the Filter Properties dialog provides settings for each of the 
individual channel outputs. 

The polarity of each channel can be inverted. This may be necessary with some types of 
crossover, or to correct for absolute phase with some types of amplification. 

Note: during testing of a speaker, the individual outputs can be inverted in the IO 
Manager. However, for permanent storage into a configuration, any polarity inversion 
must be set on this tab. 

Individual outputs can have their filtering disabled: 

While normally left at “On,” setting a driver to “Bypass Speaker Settings” sends the 
unfiltered signal to that driver. Setting it to “Off” turns off that driver. 

Use “Bypass Speaker Settings” with great caution, as the driver will receive the full 
frequency range signal. This can potentially damage a driver. 

The Time/Level tab has adjustments for delay and gain. These values apply to the 
whole “speaker” – that is, both drivers in a bi-amp configuration, or all three drivers in a 
tri-amp configuration. 

(The delay and gain of individual drivers cannot be set here because DEQX-Cal 
calculates them when creating the correction/crossover filter.)
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14 USING MULTIPLE DEQX UNITS 

Multiple DEQX units can be combined to build more complex active speakers, as well as 
multichannel systems for home theater. A single master DEQX unit can control up to 
nine slave DEQX units for volume and profile selection. 

Note that all of the configurations described in this chapter are considered to be 
advanced configurations. We strongly recommend that you enlist the assistance of a 
DEQXpert to ensure that your system is commissioned and configured correctly. 

14.1  MASTER-SLAVE CONTROL 

Any DEQX unit can act as a master, with the proviso that only the 
HDP-4 and HDP-5 provide the digital pass-through necessary to 
realize some configurations. The HDP-4, HDP-Express II, and 
PreMate can act as slave units. (The HDP-5 and PreMATE+ cannot 
be used as slave units.) 

Multiple DEQX units are connected via their RS-232 ports. The 
master unit sends volume control and profile selection commands 
to the slave unit(s). The RS-232 connecting cable from DEQX to 
DEQX must be a fully-wired straight-through cable. Sometimes, 
this cable is referred to as an “RS-232 extension cable.” A cable 
without all connections or with loopbacks (such as a “null 
modem” cable) will not work. 

With the PC connected to the slave DEQX unit and DEQX-Cal running, open the 
Options dialog to disable the slave’s front panel and remote control (see page 151). This 
ensures that the master is the only unit that responds directly to user input: 

Note that Preference EQ commands are not transmitted over the RS-232 interface. 
Preference EQ will therefore be operational on the master unit only. In some cases, this 
detail will affect the choice of connections – that is, which drivers or speakers are driven 
from the master unit and which are driven from from the slave(s). 
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14.2 MULTI-AMP STEREO CONFIGURATIONS 

Two DEQX units can be used to create an active speaker of up to 5-way, or 4-way with 
mono or stereo subwoofers.5 The master must be an HDP-4 or HDP-5 (these two 
models are the only ones with a Digital Thru output). The slave can be a PreMATE, 
HDP-Express II, or HDP-4. (Legacy models may also work as slaves – contact DEQX 
Support if needed.) 

Table 4 lists a comprehensive set of usable configurations. (It is assumed here that the 
tweeter is handled by the master and the lowest frequency driver by the slave. The roles 
can be reversed if desired.)  

Figure 9 illustrates the connections for a “4-way with mono sub” configuration. 

Connecting the master and slave units is straightforward. The RS-232 output of the 
master is connected to the RS-232 input of the slave. In addition, the Digital Thru 
output of the master is connected to the Digital 2 input of the slave. See Figure 8. 

To configure the slave unit in DEQX-Cal, open the Options dialog (from the Tools menu) 
and disable the front panel buttons and remote control. In the IO Manager, select 
Digital 2 as the input source. 

                                                                    
5 A 6-way speaker (or 5-way plus subs) is usually not practical, because of limitations in how low 
the mid-high crossover on the “lower” unit can be set. 

Figure 8. Connections between master and slave DEQX units 
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When measuring, calibrating, and configuring the two DEQX units, it is easiest to use a 
single project for both units. It is not possible to connect both DEQX units to the 
computer at the same time, so simply reconnect the USB cable to the unit being 
worked on. (If you choose to use multiple projects, create both first and then load them 
both into DEQX-Cal with “Insert Project...” – see page 149.)  
 

Table 4. Multi-amp active configurations with two DEQX units 

*1 Speaker outputs disabled in the slave unit. 
*2 Subwoofer outputs disabled in the master unit. 

Overall Configuration Master Configuration Slave Configuration 
3-way with sub/s Tri-amp Single amp + mono/stereo sub/s1 

Bi-amp + stereo subs Single amp + mono/stereo sub/s1 
Bi-amp2 Single amp + mono/stereo sub/s  

4-way Tri-amp Single amp + stereo subs1 
Bi-amp2 Single amp + stereo subs  

4-way with sub/s Tri-amp Single amp + mono/stereo sub/s 
5-way Tri-amp Single amp + stereo subs 

Figure 9. Multi-way active speaker with master and slave DEQX 
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14.3 MULTICHANNEL OR HOME THEATER CONFIGURATIONS 

Multiple DEQX units can be slaved in a multichannel or home theater system. All slave 
units are set to a fixed input (usually one of the analog inputs) and have audio provided 
from a multichannel decoder or A/V processor. (The Digital Thru of the master is not 
used in this type of system.) 

A typical configuration is to use a PreMATE+ as the master unit, and PreMATE or HDP-
Express II units for the slaves. The RS-232 connections are “daisy chained” from master 
to slave to slave. Figure 10 illustrates the key connections for a 5.1 system. Expansion to 
higher numbers of channels is straightforward. 

To configure each slave unit in DEQX-Cal, open the Options dialog (from the Tools 
menu) and disable the front panel buttons and remote control. In the IO Manager, 
select either Analog 1 or Analog 2 as the input source. 

If desired, active speakers on all channels can be implemented by using an HDP-5 as the 
master unit and HDP-4 or HDP-Express II units for the slaves. 

Figure 10. Multichannel or home theater DEQX system 
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15 DEQX CONTROL PANEL REFERENCE 

The DEQX Control Panel displays the current status of the 
connected DEQX unit. In contrast to the configuration 
window, the Control Panel manages “real time” information 
about the DEQX, including volume, input selection, room 
EQ and per-channel delay and level controls. 

At the left of the Control Panel is a strip that displays the master volume 
slider and profile selectors. The status indicator at the top is green if 
DEQX-Cal detects connection to the DEQX. It turns red if clipping is 
detected (page 135). 

Click and drag the slider to adjust master volume. The numeric display 
above the slider shows the exact volume setting in dB. Once the slider 
has been clicked on, volume can be adjusted in fine (0.1 dB) steps with 
the up and down arrows on the keyboard. 

The Mute button mutes all output channels. Mute is automatically 
engaged by DEQX-Cal in some circumstances, such as when the 
microphone input is selected and a measurement is not in progress. 

The four Profile buttons select the profile currently being used for 
processing by the DEQX. These are equivalent to the profile selection 
buttons on the DEQX Remote and the front panel. 

The Download button downloads all filters resident in the DEQX to the 
Control Panel for display. 

To the bottom of the Control Panel is a row of four tabs, which select 
different information and control displays. They are described in detail 
in the rest of this chapter.  

Selecting the Filters tab or the Configuration tab, pressing Download, 
and then cycling through the four Profile buttons will provide at-a-
glance confirmation of the data loaded into each profile. 
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15.1 IO MANAGER 

The IO Manager is the real-time control interface to the connected DEQX unit. It is 
selected by the IO Manager tab at the bottom of the DEQX Control Panel. 

15.1.1 Input Select 

The main input source buttons are the same as the DEQX Remote. 

Button Selected input 
Analog 1 Unbalanced analog (RCA) 
Analog 2 Balanced analog (XLR) 
Digital 1 TOSLINK (optical) 
Digital 2 S/PDIF on BNC 
Digital 3 S/PDIF on RCA 
Digital 4 AES/EBU (XLR) 

USB USB Audio (see Appendix B) 
Auto HDP-5 and PreMATE+: The DEQX is put into 

networked streaming audio mode (see Appendix C). 

HDP-4, PreMATE, and HDP-Express II: The DEQX 
plays the last-selected digital or analog source, 
according to which has signal. 

If Microphone is selected, the microphone is the active input source. 
Normally, it is not necessary to select the microphone as input, as 
the DEQX will automatically switch to the microphone when 
necessary. However, by manually selecting the microphone as input, 
the Microphone Setup area becomes active (see pages 44 and 134). 
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15.1.2 Inputs 

The input meters show the level of the selected input. Levels are displayed relative to 
full scale input, so “𝟢” is full scale input, “20” is 20 dB below full scale input, and so on. 

The buttons underneath the meters modify the default stereo input as follows: 

Solo 

Only the input channel with “S” pressed will play. 

Mute 

The input channel with “M” pressed will be muted. (Solo and Mute are mutually 
exclusive – muting a channel will automatically turn off Solo, and vice versa.) 
Press the “R” button to the right of the Solo and Mute buttons to restore normal 
operation. 

Mono 

If the left Mono button is pressed, the left input signal will be sent to left and right 
outputs. If the right Mono button is pressed, the right input signal will be sent to 
left and right outputs. This is useful for checking center imaging. 
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15.1.3 Outputs 

The output meters show the level of the respective output channels. Levels are 
displayed relative to full scale output, so “𝟢” is full scale output, “20” is 20 dB below full 
scale output, and so on. 

The buttons underneath the meters modify the output signal for each channel. These 
controls are intended for use in testing, prototyping, and speaker design work. 

For permanent storage of any values set here, it is necessary to a) update the 
configuration with the desired delay, gain and polarity settings, and b) reset these 
parameters in the IO Manager. 
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Solo 

Only the output channels with “S” pressed will play. Use this to select a single 
speaker, subwoofer or driver to check for correct connections. Or by selecting a 
pair of speakers or drivers and playing a mono signal, correct polarity can be 
checked (see “Polarity” below). 

Mute 

The output channels with “M” pressed will be muted. (Solo and Mute are mutually 
exclusive – muting a channel will automatically turn off Solo, and vice versa.) 
Press the “R” button to the right to reset all Solo and Mute buttons. 

Pol’ (Polarity) 

If pressed, the polarity of the corresponding output channel is inverted. Use this 
to invert one of a pair of speakers or drivers to check for correct relative polarity – 
when polarity is correct, a mono input signal will produce a solid center image. It 
can also be used while checking subwoofer integration. 

Gain 

Click the up or down arrows to increase or decrease the gain of that output 
channel in 0.5 dB increments. 

Delay and group 

Click the right or left arrows to increase or decrease the delay of that output 
channel in approximately 1.3 ms increments. Delay can only be positive. 

Channels can be grouped by pressing the dark blue button. Changing the delay on 
any one of a grouped set of channels will change the delay of all grouped 
channels. For example, by grouping the main speakers, incrementing the delay 
can be used to check the audible integration with subwoofers. Press the “R” 
button to the right to reset delays and grouping. 



DEQX User Manual 

 134 

15.1.4 Setup 
Microphone Setup 

The Microphone must be selected as the input source to change these settings. 

Input Units 

If dBFS is selected, the input meter will display the 
microphone input volume relative to a full scale signal (in 
the same manner as for other inputs). If dB SPL is 
selected, the input meter will display the actual sound 
pressure level (SPL) measured by the microphone. 

Correction 

Use the drop-down menu to select the microphone 
correction to use. The microphone correction must have 
been previously loaded from a calibration file with “Install 
Microphone...” (page 44). 

For accurate results with your DEQX, you must select a 
microphone correction. 

Phantom 48V 

Enable phantom power to the microphone. This must be 
enabled for the DEQX Standard and Reference Calibration 
Kits. (If you are not using a DEQX Calibration Kit, check 
whether your microphone requires 48V phantom power.) 

Digital Output Setup 

Clock Source 

This drop-down menu is to support DEQX legacy products with an external word 
clock input. For current generation products, leave this set to “Auto.” 

Output Selection 

This drop-down menu is to support DEQX legacy products. For current generation 
products, leave this setting at the default, “Analog/Digital.” 
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Digital Upsample 

This option is to support DEQX legacy products. For current generation products, 
this setting is effectively always on. 

Analog 96 kHz 

This option is to support DEQX legacy products. For current generation products, 
this setting is effectively always on. 

15.1.5 Status 

Digital 

Indicates the status of the internal digital processing. In normal operation, the 
two fields will say “Filtering” and “96000Hz.” 

Clipping 

If clipping is detected on the analog inputs, the status indicator “Clipped In” 
lights; if clipping is detected on any output channel, the status indicator “Clipped 
Out” lights. In addition, the connection status above the master volume slider and 
the level indicator above the relevant input or output channel will turn red. The 
I/O LED on the front panel will also light white. 
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15.1.6 System 

This area provides system status and diagnostic information. Provide this information 
to DEQX Support in the event of a trouble-shooting request.  
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15.2 EQUALIZER TAB 

The Equalizer tab is used to set up room EQ for each profile. As this tab is in the 
IO Manager, changes made here take effect in real time – in other words, changes will 
be heard immediately if music is playing. For permanent storage, the room EQ settings 
must be loaded into a configuration and saved with the project (see page 102). 

The general procedure for using this tab is as follows: 

1. Take a room measurement. 

2. Open the room measurement in the Equalizer tab. 

3. Select the profile that you want the EQ to be loaded into. 

4. Add EQ control points to set up the EQ. 

5. Fine-tune EQ settings by listening. 

6. Confirm EQ with another room measurement. 

7. Open the configuration and download the EQ settings from the DEQX (“Read 
EQ from DEQX”). 

8. Upload the configuration back to the DEQX (“Save All to DEQX”). 

9. Save the project. 
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15.3 CONFIGURATION TAB 

The Configuration tab displays the configuration data that is currently loaded into the 
connected DEQX. Click the Profile buttons to view the configuration of each profile. 

This tab cannot be used to modify the configuration. (To modify the configuration, 
open the configuration window and update it as described on pages 73 to 79. Then click 
the Save All to DEQX button to upload the updated configuration to the DEQX.) 

15.4 FILTERS TAB 

The Filters tab displays the filters that are currently loaded into the 
connected DEQX. Click the Download button to fetch the current set of 
filters, then click the Profile buttons to view the filters loaded into each 
profile. This tab cannot be used to change the filters. (To change the filters, use the 
configuration window as described above.) 
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16 DATA VIEWER REFERENCE 

All measurements taken with the DEQX can be viewed using the data 
viewer. This window can also be used to view correction filters. The data 
viewer has been shown by example in earlier chapters of this manual. This 
chapter describes its capabilities in detail. 

Note that the Equalizer tab of the Control Panel is a customized version of the data 
viewer, and most of the operations described in this chapter also apply to it. 

16.1 TO OPEN A MEASUREMENT FROM THE PROJECT EXPLORER 

In the project explorer, navigate to the measurement or correction filter that you want 
to view. Then do one of the following: 

1. Right-click to open the popup menu and select “View.” This will open the 
measurement or filter in a new data viewer. 

 

2. Drag and drop the measurement or filter from the project explorer onto an already-
open data viewer window, or onto the Control Panel’s Equalizer tab. 
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16.2 TO OPEN MEASUREMENTS WITH THE VIEWER WIZARD 

The viewer wizard makes it easy to open multiple measurements at once. 
Start the wizard by clicking on the Viewer button in the Wizard toolbar, or 
by selecting it from the Tools menu. The wizard proceeds through three 
screens, as follows: 

Screen 1. If you have more than one project open (page 149), select the project 
containing the measurements that you wish to view. Otherwise, this is just an 
informational screen. 

Screen 2. To open existing measurements for viewing, select “Load old measurements 
or filters into a new viewer.” From the pane that appears underneath, unfold folders and 
select the measurement or measurements that you wish to open: 

Alternatively, to create a new data viewer into which measurements can be loaded 
later, select “Create a blank measurement viewer.” 

Screen 3. If you opted for a blank data viewer, just click Finish. If you selected 
measurements to display, the wizard will by default suggest that you open the selected 
measurements in a new data viewer window: 

You can instead use the drop-down menu to open the selected measurements in an 
existing data viewer window or in the Equalizer tab of the Control Panel: 

Click Finish to open the selected measurements. 
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16.3 THE DATA VIEWER WINDOW 

The data viewer window displays any number of measurement plots. The screenshot 
below is annotated with the main areas of this window: the viewer toolbar, the plot 
display area, and the plot selector. 

 

If the plot selector is not visible, click on the bar at the bottom of the window and drag it 
upward to expose the plot selector: 

 

 

To add more measurements to an open data viewer, drag and drop them from the 
project explorer onto the open viewer. 
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16.4 OPERATING ON MEASUREMENTS 

The chart toolbar, viewer toolbar, and plot selector provide a comprehensive set of 
functions for viewing and manipulating measurement plots. 

To select individual plots for display: 

Click on the checkboxes in the Show column of the plot selector.  

 

To change plot color or line style: 

Click in the Col or Line column and select a color or line style. 

To set plot smoothing: 

Click in the Smooth column and type in the new smoothing amount (𝟢 to 𝟣𝟢𝟢%). 
Smoothing serves to make measurements more legible by removing comb 
filtering (particularly when measuring indoors). It is also an adjustment that is 
made to control speaker calibration (see pages 57 and 114 for examples). 

 

In addition to the individual adjustment for each plot, 
all selected plots can have their smoothing changed 
with the slider at the left of the viewer toolbar. 

 

To change plot scale: 

Click in the Scale column and enter a value. This value adjusts the offset of the 
plot relative to the decibel scale on the left hand side. It is used to align plots to 
calculate gain levels and to aid in room EQ. (See page 93 for an example.) 

To normalize plots: 

Click the Normalize to 𝟢 dB button. The selected plots will have their scale values 
changed so that the signal level is nominally at 𝟢 dB. 

To remove a plot or plots from the display: 

Select the plots to be removed and click the Remove button. 
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To create a summed plot: 

Select the plots to be summed and click the Sum button. (See page 104 for an 
example.) 

To zoom in and out on a plot: 

Click on the “+” magnifying glass icon in the chart 
toolbar. Then, either click once on the plot display 
area, or drag-select a region to zoom in on it. To zoom out, click on the “−” 
magnifying glass icon and then on the plot. By default, the zoom buttons are 
“sticky.” To have the zoom buttons reset themselves after each click, right-click 
on the plot display area and uncheck the option “Keep zoom after each click.” 
(See also “To change plot axis limits” on the next page.) 

The plot display area responds to a right-button mouse-click by bringing up a context 
menu. The menu entries depend on where the click is, as shown in this overlay: 

To change the title of a plot: 

Right-click on the title bar and select “Edit.” Type in the new name and click OK. 

To disable the X or Y-axis display 

Right-click on either axis and turn off the “Axis” entry. Alternatively, right-click on 
the main plot display area, open the “Customize” sub-menu, and turn off “Display 
X Axis” or “Display Y Axis.” 

To disable the chart grid: 

Right-click on the main plot display area, open the “Customize” sub-menu, and 
turn off “Display X-Grid” or “Display Y-Grid.” 
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To add markers to the plot: 

Right-click on the plot display area, 
open the “Markers” sub-menu, and 
select either “Vertical” or “Horizontal.” 
The markers can then be dragged to 
the desired location. 

 
 

To change plot axis limits: 

The “+” and “−” magnifying 
glass icons change the 
displayed plot range within the 
overall limits, which are by 
default set automatically. To 
set these limits manually, 
right-click on the plot display 
area and select “Modify Axes 
Limits.” Uncheck the 
Autoscale checkboxes and 
enter the desired limits. 

Other changes to the plot display can be made in the Chart tab of the Options dialog 
(pages 153 and 154). 

16.5 VIEWING THE IMPULSE RESPONSE 

Click the TIME button on the chart toolbar to display 
the impulse response of the selected measurements. 
The impulse response is used to calculate timing 
delays (see pages 56 and 95 for examples).  
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17 PROJECT EXPLORER REFERENCE 

The project explorer is used to navigate and manage a project. Various ways of using 
the project explorer have been described in earlier chapters. This chapter provides a 
more complete reference. 

Note that it is not always necessary to use the project explorer. The various wizards 
provide the ability to create and open measurements, calibration templates and 
configurations without using the explorer. 

The project explorer is more likely to be useful to advanced users who are creating 
multiple measurements and correction sets, as it provides an at-a-glance view of the 
complete set of data in the project. Even so, it is recommended that a project not be 
allowed to get too large. (For example, consider creating a new project when starting a 
fresh measure-calibrate-configure cycle.) 

17.1 WORKING WITH PROJECTS 
To open the project explorer: 

Drop down the View menu and select “Project explorer.” 

To create a new project: 

Drop down the File menu and choose “New Project.” Alternatively, click on 
the “New” icon in the toolbar. Enter the name of the new project and click 
OK. Initially, the project is unpopulated:  

 

To open an existing project: 

Drop down the File menu and choose “Open Project.” Alternatively, click 
on the “Open” icon in the toolbar. Select the project in the file browser and 
click OK. You can also open a project by double-clicking on it in the Windows 
Explorer. 
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To save the active project: 

Drop down the File menu and choose “Save Project.” Alternatively, click on 
the “Save” icon in the toolbar or press Ctrl-S on the keyboard. 

To close a project: 

Right-click on the project name and select “Close.” The currently open project will 
also be closed when a new project is created or an existing project is opened. 

To move or undock the project explorer: 

The project explorer can be moved to other locations by dragging its grab-handle 
(the double horizontal line just above or to its left). It can also be undocked from 
the main window by dragging it well away to a blank area of your screen. Here is 
the result: 

17.2 PROJECT FOLDERS 

The project consists of four main folders. These folders will be populated as you take 
measurements, create calibrations, and so on. To open a folder, click on the “+” icon or 
double-click on its name. To close it, click on the “−” icon or double-click on its name. 

In the following screenshots, the folders created by DEQX-Cal are shown highlighted.  

SPEAKERS 

This folder contains items identified by the combination of speaker manufacturer, 
model, and serial number. Under each, there are two folders: CORRECTIONS, 
containing correction filters generated for that speaker, and MEASUREMENTS, 
containing measurements made of that speaker. 
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CALIBRATION TEMPLATES 

This folder contains calibration templates. Each of these contains two folders: 
MEASUREMENTS, which references measurements used by that template, and 
CORRECTION SETS, which contains sets of correction filters. 

Note that the correction filters and measurements here are references or aliases 
to the items contained under SPEAKERS. Therefore, deleting a calibration 
template does not delete the filters or measurements that it references. 

 

ROOM MEASUREMENTS 

This folder contains sets of measurements for each room. The top-level list of 
items is the list of room names. Within each room is the list of measurement 
positions, each of which contains measurements for the speakers or drivers.  

 

PDC CONFIGURATIONS 

This folder contains DEQX configurations. Each configuration contains four 
profiles, with default names as shown below. 
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17.3 EXPLORER OPERATIONS 

Right-clicking on any folder or item in the project explorer will open a context-sensitive 
menu that provides a number of common operations. The possible operations will differ 
by the folder or type of item. 

Open (or View) 

Open the item in a data viewer (for measurements, correction filters and 
individual profiles) or in the appropriate type of window (for calibration templates 
and configurations). In the case of room measurements, multiple measurements 
can be opened at once by right-clicking on a measurement position. 

Rename 

Rename the clicked-on item. The new name can then be typed over the old one. 
You can also click on an item and then click again to enable renaming (but not 
quickly enough to be registered as a double-click.) 

Delete 

Delete the clicked-on item from the project. 

Note that deleting a calibration template does not delete the measurements or 
correction filters that it references – those are contained in the SPEAKERS folder.  

Use caution when deleting items. It is strongly recommended that you close all 
relevant windows before deleting any item from the project explorer. Do not 
delete correction filters or speaker measurements that are in use by a calibration 
template or a configuration. Avoid deleting calibration templates that were used 
to create correction filters that are in use by any configuration. 

Drag and Drop 

Speaker measurements, room measurements, correction filters and profiles 
(within a configuration) can be dragged from the project explorer onto an open 
data viewer or onto the Equalizer tab of the Control Panel. In the case of room 
measurements, a measurement position or just a single speaker or driver 
measurement can be dragged and dropped. In the case of a profile, the filters that 
it contains will be displayed. 

Copy and Paste 

This is essentially the same as drag and drop, and applies to the same items listed 
above for drag and drop. Select the item and then “copy” it by pressing Ctrl-C on 
the keyboard. Then click once in an open data viewer or on the Equalizer tab of 
the Control Panel and press Ctrl-V on the keyboard. 
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17.4 WORKING WITH MULTIPLE PROJECTS 

The project explorer can open more than one project at a time. 

Note: this feature is not intended as a general-purpose mechanism for sharing data 
between projects. The primary purpose of this function is to enable the speaker 
designer to create a project for distribution – that is, a project containing only what is 
needed to upload a configuration to a DEQX in a different physical location, without all 
of the other measurements and templates that may have been created during the 
design process. 

In general, it is best to use a single project for development work, even when using 
multiple DEQX units (Chapter 14). 

To open a second (or third etc.) project, drop down the File menu and choose “Insert 
Project...” Select the project in the file browser and click OK. The project is added to the 
project explorer: 

Right-clicking on a project name provides two options: 

Set as Active Project 

The active project is the default selection on the first screen of each wizard. It is 
also the project used for operations like Save. 

Remove Project 

Remove this project from the explorer. 

If multiple projects are open, the various wizards provide an option on their first screen 
to select the project to use for following steps. By default, the active project is selected, 
but any other open project can be selected instead: 

Note that it is not possible to have (for example) a calibration template in Project B 
create a correction filter based on a speaker measurement that is in Project A. Each 
wizard operates within the confines of the selected project. 
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There are two ways to copy data between projects: 

� Room measurements. Drag and drop a “room” (the top level item) from the ROOM 
MEASUREMENTS folder of one project onto the ROOM MEASUREMENTS folder of 
another project. All of the measurement positions and the individual measurements 
underneath them will be copied over. 

� Configurations. Drag and drop a configuration from the PDC CONFIGURATIONS 
folder of one project onto the PDC CONFIGURATIONS folder of another project. All 
of the data associated with that configuration will be copied over, including EQ 
settings, correction filters, and the speaker measurements used to create the 
correction filters. 

While the intent of multiple projects is to create a project for distribution and not as a 
way to continue development work, it is still possible to create calibration templates 
from the data contained in a copied configuration. This feature is provided so that 
refinements or adjustments to correction filters can be made on-site i.e. after 
distribution of the project. (It is not intended to be a way to recreate the full original 
calibration template in a different project.) 

1. Open the configuration and select the profile containing the relevant correction 
filters. 

2. Click on one of the speaker or subwoofer icons. 

3. Click the “Open Template” button. (Or right-click anywhere in the 
Configuration tab and select “Open Template” from the popup menu.)  

4. You will be asked if you wish to recreate a calibration template from the selected 
speaker. Click “Yes.” 

 

5. A new calibration template will be created. 
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18 OPTIONS AND CUSTOMIZATION 

DEQX-Cal has many configuration options that control its behavior and appearance. 
This chapter provides a reference for them. 

18.1 OPTIONS DIALOG 

The Options dialog is opened from the Tools menu. After changing any options, click 
Apply to make them take effect without closing the dialog, or OK to make them take 
effect and close the dialog. 

18.1.1 Configuration tab 

This tab holds most of the key options. (See the next two pages for descriptions.) 
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Hardware 

Selects the port that the computer uses to communicate with the DEQX. This 
must always be set to USB for current generation software and products. (The 
RS-232 mode is retained for specific legacy support reasons only.) 

This setting has no effect on master/slave mode operation (Chapter 14). 

Units 

The measurement system that DEQX-Cal uses for recorded distances. 

Name-Library File 

The location and name of the file that DEQX-Cal uses to store names added by 
the user (manufacturers, speaker models, measurement locations, and so on). 
This must never be changed except on specific instruction from DEQX Support. 

Default Project Location 

The directory that DEQX-Cal uses by default for storing project files. This can be 
changed if you prefer to store projects in a different location (for example, on a 
network drive or external hard drive). 

Enable separate digital/analog volume control 

If checked, the DEQX remembers two volume control settings: one for the analog 
inputs and one for the digital inputs. Changes to the master volume setting will 
affect one or the other according to whether an analog or digital input is selected 
at that time. 

As an example usage of this feature: if the analog input is connected to the left 
and right outputs of a home theater processor and the analog volume is set to 
maximum, this effectively creates a “home theater bypass.” 

Disable Front Panel Controls 

If checked, the front panel controls for volume and profile selection do not 
respond. (The Standby button still operates.) This is used when the DEQX is set 
up as a slave unit (Chapter 14). 

Disable Remote Control 

If checked, the DEQX does not respond to remote control commands. This is used 
when the DEQX is set up as a slave unit (Chapter 14). 

Disable Front Panel LED Fadeout 

Leave this option turned on. 

Reload last project at startup 

If checked, DEQX-Cal reloads the project that was in use when it was previously 
closed. This is a convenience feature, and is checked by default. 
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Save project file after each measurement 

If checked, DEQX-Cal saves the whole project after completing each 
measurement. It is checked by default. 

Automatically highlight new items in project 

If this option is checked, any new item (measurement, calibration template, or 
configuration) added to the project is highlighted in the project explorer. Folders 
above the new item will be unfolded. It is checked by default. 

Show hint text in charts 

If this option is checked, some charts have text overlaid with short instructions on 
how to use them. (For example, the Anechoic tab of the calibration template.) It is 
checked by default. 

Reset “Do not show again” warnings 

DEQX-Cal has a number of warnings with a checkbox “Do not show again.” Click 
this button to reset the state of these warnings so that they will display again. 

18.1.2 Chart tab 

This tab is used to customize elements of the various charts in DEQX-Cal, such as the 
title, labels, and grid lines. 

To make changes to all charts, leave the “All Same” option checked. Uncheck it and use 
the drop-down selector to change just one chart type: 
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Standard View 

This refers to most charts: the data viewer, the Equalizer tab of the control panel, 
and the Anechoic and Smoothing tabs of the calibration template. 

Correction View 

This refers to the tabs of the calibration template that display the correction filter 
sets (named “Correction Set 1” and so on by default). 

Limit Design View 

This refers to the Limits tab of the calibration template. 

Crossover Design View 

This refers to the Crossovers tab of the calibration template. 

Use the checkboxes on the left of the dialog to set the items displayed by default on the 
selected chart type. Most of these can also be disabled and enabled for individual charts 
(see page 143). 

The right side of the dialog box is used to set colors and fonts. To change colors and 
fonts specifically for DEQX-Cal, uncheck “Sync with system colors,” then click the Font 
or Color button to make the desired changes. 

18.1.3 DEQX tab 

This tab controls the appearance of the configuration window.  

If the Properties option is checked, the configuration window displays the parametric 
room EQ filter settings and the key correction and limit filter parameters (in text). If 
unchecked, this information is not displayed. It is checked by default. 

The right side of this tab can be used to change the colors and fonts of items in the 
configuration window. Uncheck “Sync with system colors,” select the item from the list, 
then click the Font or Color button to make the desired changes. 
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18.2 CUSTOMIZE DIALOG 

The Customize dialog is opened from the Tools menu. Changes made in this dialog take 
effect immediately. 

18.2.1 Commands tab 

Use this tab to add commands to toolbars or menus. (For examples, see page 158.) 

 

To add a command: 

Locate the desired command by selecting the category on the left, and then the 
command on the right. Drag the selected command onto: 

x An existing toolbar, or 

x A menu in the main menu bar (the menus will unfold as the drop cursor is 
moved over them). 

To add a new menu: 

Select the “New menu” category on the left, and drag the item “New menu” on 
the right onto a menu bar. (It can also be dragged onto a toolbar.) 

To rename or delete an item from a menu or toolbar: 

While the Customize dialog is open, right-click on the menu or toolbar item that 
you want to change. Select “Edit” to change its name, or “Delete” to remove it. 
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18.2.2 Toolbars tab 

Use this tab to create and delete toolbars. 

To create a new user-defined toolbar, click New and enter the toolbar name. It will 
appear as a separate toolbar window (below right). Then: 

1. Go back to the Commands tab and 
drag and drop commands from it onto 
the new toolbar window. 

2. Drag the new toolbar window onto a toolbar location (such as next to an existing 
toolbar) to dock it to the main window. 

18.2.3 Keyboard tab 

Use this tab to set up keyboard shortcuts for commands. 
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18.2.4 Menu tab 

Use this tab to customize the context menus that appear in various places in DEQX-Cal 
when the right mouse button is clicked (such as the project explorer and data viewer). 

 

To edit a context menu, select it with the drop-down on the 
right-hand side. It will appear as a separate window as 
shown at right. Then go back to the Commands tab and 
drag commands from it onto this separate window. Or, 
right-click on an entry in this window to delete or edit it. 

To reset the selected menu to its defaults, click the Reset 
button (while the window is still open). 
 

18.2.5 Options tab 

This tab contains a small number of additional options. 

The “Show Screen Tips on toolbars” option controls the tooltip that appears when 
hovering the mouse over any toolbar item. The “Show shortcut keys in Screen Tips” 
option also enables display of the relevant shortcut key.   
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 ADDING TEXT LABELS TO THE CONFIGURATION TOOLBAR  

The toolbar of the configuration window is quite small. Especially when editing a 
profile, it can be hard for a novice user to distinguish the buttons. It is simple to add text 
labels to this toolbar, as follows: 

1. Open the configuration window (if it is not already open). 

2. Open the Customize dialog and select the Toolbars tab. 

3. Click on “DEQX Configuration” at the left. 

4. Turn on the “Show text labels” checkbox. 

The toolbar of the configuration window will display as shown below (the image shows 
the toolbar split for space reasons, but in DEQX-Cal it will be a single row). 

Note: if you are an advanced user and have more than one configuration in your project, 
this will need to be done separately for each of them. 

 
 

 MAKING AN AUXILIARY CHART TOOLBAR  

To create an auxiliary toolbar for common chart operations:  

1. Open the Customize dialog and select the Toolbars tab. 

2. Click on New, enter “Chart Tools 2” and click OK. A small window appears. 

3. Go to the Commands tab, click on the Chart category, and drag these 
commands onto the new toolbar window: “Y Labels Inside”, “Keep zoom after 
each click”, “Axes Limits...”, and “Vertical”. 

4. Right click on each item in the new toolbar window and select “Button 
Appearance” to edit the label. 

5. Drag the toolbar window onto the main window to dock it. 

Here is the result: 
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 SPECIFICATIONS 

Specifications are subject to change without notice. 

AUDIO PROCESSING 

*1 Available slopes are subject to filter delay limits. 
*2 Ten bands available if Preference EQ is not needed. 

DIGITAL AUDIO INPUTS 

DIGITAL AUDIO OUTPUTS (*3) 

*3 All digital outputs are S/PDIF via BNC 75Ω connector. 

Crossover slope (*1) 48 to 300 dB/octave (linear-phase) 
6 to 96 dB/octave (Linkwitz-Riley and Butterworth) 

Crossover frequency 22 to 18,340 Hz 
Limit filters (*1) 6 to 300 dB/octave, 20 Hz to 20 kHz 
Latency From 2.5 ms, typically 15 ms depending on filters 
Group delay tolerance Better than 0.5 ms, typical 
Amplitude tolerance Better than 0.2 dB, typical 
Room EQ (*2) Seven bands, 1 Hz to 48 kHz, −300 to +40 dB, Q 0.01 to 17 
Preference EQ Three bands, 20 Hz to 20 kHz, gain to +/− 9 dB, Q 0.5 to 10 
DSP resolution > 140 dB 

TOSLINK (optical)  24-bit, 44.1 to 96 kHz 
S/PDIF (BNC) 24-bit, 44.1 to 192 kHz, 75Ω 
S/PDIF (RCA) 24-bit, 44.1 to 192 kHz 
AES/EBU (XLR) 24-bit, 44.1 to 192 kHz, 110Ω 
USB Audio Asynchronous USB Audio Class 2, 24-bit, 44.1 to 192 kHz. 

Driver not required for Mac OS X; XS-1 driver supplied for 
Microsoft Windows. 

 HDP-4, HDP-5 PreMATE, PreMATE+ HDP-Express II 
Digital Thru  24-bit, 96 kHz — — 
Low 24-bit, 96 kHz — — 
Mid/Full 24-bit, 96 kHz 24-bit, 96 kHz — 
High 24-bit, 96 kHz — — 
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ANALOG AUDIO INPUTS 

*4 Jumper-selectable to reduce sensitivity (see Appendix D). The given value is the factory 
default. 

ANALOG AUDIO OUTPUTS 

*5 Not applicable to HDP-Express II. 
*6 Jumper-selectable in five ranges up to 22.3 dBu balanced, 15.7 dBu unbalanced (see 

Appendix D). The given value is the factory default. 
*7 Into an earth-referenced amplifier i.e. one where the RCA ground pin connects to mains 

ground. This is normally the case. The precise output impedance is 75 ohms, plus 75 ohms in 
parallel with whatever the amplifier puts in series between its RCA connector and mains 
ground. If the latter is open, then the impedance can be as high as 150 ohms (such as may 
happen with a two-pin power connector). 

CALIBRATION KIT 

HARDWARE AND GENERAL 

 Balanced Unbalanced 
Full scale input level 17 dBu / 5.5 VRMS 9.3 dBu / 2.25 VRMS (*4) 
Input impedance 50 kΩ 50 kΩ 
A/D convertor 24-bit, 96 kHz 
Signal-to-noise ratio 107 dB, A-weighted 

 Balanced (*5) Unbalanced 
Full scale output level (*6) 17.4 dBu / 5.7 VRMS 10.8 dBu / 2.7 VRMS 
Output impedance 150 Ω 75 Ω (*7) 
Frequency response 10 Hz – 45 kHz 
Total harmonic distortion 0 0008% (analog in to analog out) 
Signal-to-noise ratio 107 dB, A-weighted 

 Standard Calibration Kit Reference Calibration Kit 
Calibration file 20 Hz – 20 kHz 20 Hz – 35 kHz 
Maximum SPL 127 dB 140 dB 
Phantom power 48 V 48 V 

Computer control USB 2.0 
Mains input voltage HDP-5, PreMATE, PreMATE+, HDP-Express II: 100 – 240 

V AC, 50 – 60 Hz, auto-select 

HDP-4: 100 – 120 or 220 – 240 V AC, 50 – 60 Hz, switch-
selectable on rear panel 

Fuse rating 100 – 120V: 2 Amps; 220 – 240V: 1 Amp 
Power consumption 30 W (max) 
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 USB AUDIO 

All current DEQX models incorporate the XS-1 USB Audio interface board, which 
accepts USB Audio at all standard sample rates from 44.1 up to 192 kHz. 

OS X 

Driver installation is not required for OS X. Connect the DEQX USB Audio port to your 
Mac using the supplied cable. 

To set the DEQX as the default system audio output device, open System Preferences, 
click on Sound, select the Output tab, and then select xCORE USB Audio 2.0 in the list 
of output devices. In addition, audiophile-quality music players will allow you to select 
the DEQX as the output device independently of the system default.  

More detailed properties of the DEQX USB Audio port can be verified in the Audio MIDI 
Setup program by clicking on the device xCORE USB Audio 2.0, as shown here: 
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Windows 

Microsoft Windows requires that a driver be installed in order to stream audio from the 
PC to the DEQX. Once installed, the DEQX output driver (“XMOS USB AUDIO 2.0”) can 
be selected as the audio output device in any audiophile-quality music player. 

Before installing, check the upgrades section of the DEQX website 
(http://deqx.com/upgrades.php) for the latest version of the driver. 

To install the driver, first connect the USB Audio input of the DEQX to a USB port on 
your computer using the supplied cable. Turn on the DEQX with the rear panel switch, 
wait a few seconds and then take it out of standby by pressing the I/O button on the 
front panel. 

Navigate to the XS-1 USB Board -> USB Audio Windows Stereo Driver folder on the 
installation CD, and double-click on the installation program to start it. It will have a 
name similar to XMOS-Stereo-USB-Audio-Class2-Driver-2017(v2.23.0).exe. Step 
through the installer until it completes. 

 

The PC must be connected to the USB Audio input of the DEQX, and the DEQX 
powered on and not in standby, before starting the USB Audio driver installer. 
 

Correct installation of the USB audio driver can be viewed by starting the XMOS USB 
Audio 2.0 ST Control Panel (under DEQX Pty Ltd in the Windows Start Menu).  

http://deqx.com/upgrades.php
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 NETWORKED STREAMING AUDIO 

The DEQX HDP-5 and PreMATE+ provide, in addition to the multitude of digital audio 
inputs, a carefully selected set of networked streaming audio functions. In this mode, 
the DEQX acts as a destination for third-party audio playback sources (software). 

This Appendix describes supported networked audio sources. Others may work, but will 
not be supported by DEQX. (Note also that DEQX support is limited specifically to 
issues related to streaming networked audio to a DEQX unit. Core installation and 
configuration issues must be directed to the third-party hardware/software provider.) 

To enable the DEQX as a networked audio destination, connect an Ethernet cable from 
your network router to the Ethernet port on the rear panel. Then select the “Internal” 
input on the front panel touchscreen or press the “Auto” button on the DEQX Remote. 

JRiver Media Center 

JRiver Media Center (https://www.jriver.com/) is a comprehensive audio playback and 
library management suite that runs on Windows, Mac, and Linux. 

To enable playback to a network-connected DEQX, drop down the Player menu and go 
to the Zone sub-menu. Select the zone “DeqxPre,” as shown here: 

Proceed to your normal JRiver library view, hover the mouse over an album or playlist, 
and click on the “Play” overlay. The “Now Playing” section of the sidebar will show that 
“DeqxPre” is the playing destination (example shown below). Control playback volume 
from the DEQX touchscreen or with the DEQX Remote. 

https://www.jriver.com/download.html
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Roon 

Roon (https://roonlabs.com/) is a music player that runs on Windows, Mac, and Linux. It 
integrates various sources of music data, including content from the streaming audio 
service Tidal (http://tidal.com/). From the Roon website: “Roon looks at your music and 
finds photos, bios, reviews, lyrics, and concert dates, and makes connections between 
artists, composers, performers, conductors, and producers.” 

The DEQX HDP-5 and PreMATE+ are Roon Ready network players. To send audio from 
Roon to your DEQX, open Roon’s Audio Setup panel. Scroll down, and you will see 
“Deqx DeqxPre” listed in the “Networked” section: 

Click the Enable button. You can now rename the DEQX as you wish: 

Click on the “gears” icon to the right and select 192 kHz as the Max Sample Rate: 

Select your DEQX as the playback zone: 

Select music to play using the Roon interface. Roon will display your DEQX as its 
playback device (lower right of player window). Control playback volume from the 
DEQX touchscreen or with the DEQX Remote. 

https://roonlabs.com/
http://tidal.com/
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 ANALOG GAINS 

All DEQX units have settable analog gain on inputs6 and outputs7. Changing the analog 
gain is accomplished by removing the top cover and moving a set of jumpers. 

Power off the DEQX with the rear panel switch and disconnect AC mains power before 
performing this procedure. Remove the IEC plug from the rear of the unit. If you are not 
confident in your ability to perform this procedure safely, contact DEQX Support. 

TO CHANGE ANALOG GAIN 

1. Remove 14 screws from the sides and top of the unit. Depending on date of 
manufacture, a small Philips screwdriver or 2 mm Allen (hex) key will be required. 

2. Lift the cover straight up. You may need to pull the sides out slightly to do this. 

3. Change the jumpers for each channel to the desired positions (see Table 5 and 
Table 6 on page 166). Be sure that the jumpers are positioned correctly over both 
pins, as illustrated here: 

 
Do not force jumpers – they will slide easily when positioned correctly. 

4. Carefully replace the top cover. You may need to pull the sides out slightly as you 
do this. Be sure that the front edge of the top cover is flat against the rear of the 
front panel. 

5. Replace the 14 screws. Do not over tighten. 

                                                                    
6 Input gain/sensitivity applies to the single-ended (RCA) inputs only. If even lower sensitivity is 

required than provided by jumpers, use the balanced inputs with a suitable RCA-XLR adapter. 
7 The DEQX has a 6 dB insertion loss to provide headroom for equalization. Therefore, with a 

bypass profile (page 75), full scale input gives half the listed output voltage. To obtain the listed 
full scale analog output for testing purposes, set channel gains in the IO Manager to +6 dB. 
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JUMPER SETTINGS 

Table 5 and Table 6 list the full scale input or output voltage for each jumper position. 
The highlighted row indicates the default setting as shipped from the factory. 

Table 5. Analog input sensitivity jumper settings 

 Full scale single ended input dB Sensitivity 
Change Position dBu V RMS 

1–2 11.6 2.95 −2.3 
2–3 (default) 9.3 2.25 0 

 
Table 6. Analog output gain jumper settings 

 Full scale balanced output 
(typ.) 

Full scale single ended 
output (typ.) dB Gain 

Change Position dBu V RMS dBu V RMS 
1 9.8 2.4 3.2 1.1 −7.6 
2 13.1 3.5 6.5 1.6 −4.3 
3 15.5 4.6 8.9 2.2 −1.9 

4 (default) 17.4 5.7 10.8 2.7 0 
5 22.3 10.1 15.7 4.7 +4.9 

JUMPER LOCATIONS 

View the main circuit board from above and with the front panel of the unit toward you. 
The jumpers are located to the left of the DSP daughterboard as shown in the diagram 
below. The jumper positions on this diagram match those in Table 5 and Table 6 above. 
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 FIRMWARE AND EEPROM 

TO CHECK THE FIRMWARE VERSION 

Connect the DEQX to your PC and run DEQX-Cal. The firmware version will display 
toward the lower right of the IO Manager.  

TO UPGRADE THE FIRMWARE (NORMAL MODE) 

Install and run the latest version of DEQX-Cal. With the DEQX connected to the PC, 
drop down the Tools menu and select “Upgrade DEQX firmware from file...” The next 
screen will show the selected firmware file. Confirm that this is the same file as listed in 
Table 7 (on the next page), then click OK to proceed. The firmware upgrade will then 
proceed through a series of steps until successful completion. Click Finish on the final 
screen to return the DEQX to normal use. 

Do not power off or disconnect the DEQX while firmware upgrade is in progress. 

TO BOOT IN SAFE MODE 

Safe mode is intended for diagnostic and upgrade operations only. The DEQX will not 
perform any filtering while in safe mode, nor operations such as measurement. Ensure 
that all connected equipment is turned off before booting in safe mode. 

1. Turn off the DEQX with the rear panel power switch. 

2. Connect the DEQX to the PC with a USB cable and start DEQX-Cal. 
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3. Press and hold the P1, P2 and P3 buttons. While continuing to hold them down, 
turn on the DEQX with the rear panel power switch. All LEDs will flash blue. 

4. Release the three buttons. 

The DEQX-Cal status fields will indicate that it is connected in safe mode: 

To upgrade firmware while in Safe Mode, drop down the Tools menu and select 
“Upgrade DEQX firmware from file...”. It is IMPERATIVE at this point that you select 
the correct firmware file for your DEQX model, as per Table 7 below: 

Table 7. Firmware upgrade file by DEQX model 

DEQX Models Firmware file name 
PDC-2.6, PDC-2.6P, HDP-Express (Mk1), HDP-3 eqf.pdc 
DEQX Mate, PreMate, HDP-Express II, HDP-4 eqf2.pdc 
PreMate+, HDP-5 eqf3.pdc 

To exit safe mode, turn the DEQX off using the rear panel switch, and then turn it on 
again (without pressing any front panel buttons). 

TO RESET THE EEPROM 

In rare cases, it may be necessary to reset the EEPROM in order to restore normal 
function of the DEQX. The EEPROM is a non-volatile memory chip that stores the 
status of the DEQX (i.e. whether normal or in error), the master volume, parametric EQ 
settings, and other parameters accessible from the IO Manager. 

To reset the EEPROM, turn the DEQX off using the power switch on the rear panel. 
Press and hold the P3 button on the front panel, then turn the DEQX back on while 
keeping the P3 button held. This will clear any error messages and set the status of the 
DEQX to normal. In addition, it will: 

� Reset the volume to -120dB; 

� Set the current profile to Profile 𝟢; 

� Set the analog input to Analog 1, the digital input to Digital 3, and the input 
selection to Auto; 

� Remove all parametric EQ filters i.e. both room EQ and Preference EQ; 

� Clear all IO Manager per-channel settings: channel gains, channel muting, soloing, 
delay and polarity. 

Resetting the EEPROM won't remove the correction filters from the DEQX. However, 
all room EQ has been cleared, so it is recommended that the configuration now be re-
uploaded to the DEQX. 
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 TROUBLESHOOTING 

If you experience difficulties with your DEQX, consult the information below. If the 
problem persists, contact DEQX Support (see page 14), providing as much information 
as you can about the error and the results of following the steps given here. 

DEQX-CAL DOES NOT DETECT A CONNECTED DEQX UNIT 
1. Check that the DEQX is not in standby mode. 
2. Check that the USB cable is securely connected to the USB Control port of the 

DEQX. (DEQX-Cal cannot communicate with a DEQX that is connected via the USB 
Audio port. The PC must be connected via the USB Control port.) 

3. Remove any USB hubs or extenders. 
4. Connect the PC to the DEQX with the supplied USB cable. 
5. Quit and restart DEQX-Cal. 
6. Power cycle the DEQX (turn power off with the rear panel switch, wait a few 

seconds, then turn it on again). 
7. Restart the Windows PC. 

If none of the above yields a successful connection, you will need to contact DEQX 
Support. Before doing so, open the Link Debug dialog (shown below) by double-clicking 
on the link status icon at the bottom right of the DEQX-Cal window. Unplug the USB 
cable from the DEQX and then reconnect it. Click Copy, and paste the captured data 
into your support request (page 14). 
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THERE IS NO SIGNAL ON THE INPUT LEVEL METER WHEN TAKING A MEASUREMENT 

1. Check that the Microphone input is active in the DEQX-Cal IO 
Manager. 

2. Check that the Microphone Setup area in the IO Manager 
shows that Phantom 48V power is turned on. (This applies to 
microphones supplied with the DEQX Standard Calibration 
Kit and the DEQX Reference Calibration Kit. If you are not 
using a DEQX Calibration Kit, double-check whether your 
microphone requires 48V phantom power. Note that use of 
microphones not supplied in a DEQX Calibration Kit is not 
supported by DEQX.) 

3. Check that the microphone cable is plugged into the 
Microphone input on the DEQX rear panel. (Make sure that you have not 
inadvertently plugged the microphone into the Dig 4 input or the left balanced 
analog input.) 

COMMUNICATION TO THE DEQX FAILS 
1. Try the operation (e.g. “Save All to DEQX”) again. 
2. If it fails again, save the project and quit DEQX-Cal. Restart DEQX-Cal and retry the 

operation. 
3. Proceed through the steps given on page 169 for “DEQX-Cal does not detect a 

connected DEQX unit.” (Sometimes a marginal USB connection can appear to 
connect successfully, but fail on data-intensive operations.) 

4. If the operation continues to fail, contact DEQX Support (page 14). 

THE PROJECT ICON IS GREYED OUT 

The corresponding project file is read-only, preventing DEQX-Cal from updating it. This 
can happen if the project file is on a read-only medium such as a CD-ROM, or if it is set 
to read-only in the Windows file system. 

1. Close the project in DEQX-Cal and copy the project file to a writable medium (such 
as a hard drive). Then open the new copy in DEQX-Cal. 

2. If the file is already on a writable medium (such as a hard drive), check that the file 
has not been set to read-only in the Windows file system. 

THE DEQX ENTERS FAULT MODE 

Fault mode is indicated by the front panel LEDs displaying a combination of red, blue 
and yellow. The DEQX will usually not respond to any user input when in fault mode. 

1. Turn off all connected equipment and power cycle the DEQX. 

2. If the DEQX does not reboot and operate normally, or if the error recurs, contact 
DEQX Support (page 14). 
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